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ABSTRAKT 

Přístrojové transformátory proudu a proudové senzory jsou přístroje, které nejčastěji slouží k 

měření proudů v soustavách vysokého napětí. Jejich úkolem je převádět měřené proudy na 

hodnoty, které jsou zpracovatelné měřicími a jistícími přístroji.  

Teoretickou část práce zahrnuje třetí až sedmá kapitola, které se věnovány rozboru, 

konstrukce a popisu charakteristických vlastností obou přístrojů a problematice chránění 

transformátorů rozdílovou ochranou. Praktická část práce je obsažena v osmé až desáté kapitole. 

Ta popisuje průběh laboratorního měření, které má za cíl ověřit teoretické poznatky práce. Závěr 

práce je věnován vzájemnému porovnání vlastností a shrnutí výsledků laboratorního měření. 

KLÍČOVÁ SLOVA:  měření proudu; přístrojový transformátor proudu; proudový senzor; 

Rogowského cívka; třída přesnosti; diferenciální ochrany, přesycení 
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ABSTRACT 

Current transformers and current sensors are devices which are mostly used for current 

measurement in high voltage systems. These devices transform measured currents to range which 

are workable for measurement and protection devices.  

Theoretical part includes from third to seventh chapter. These chapters contain construction 

analysis and characteristic points for both device and problems of protecting the transformer with 

differential protection. Practical part includes from eighth to tenth chapter. This chapter consists 

results from laboratory measurement. Results are used for verification with theoretical part of the 

thesis. Conclusion of this thesis comparing properties and summarises results from laboratory 

measurement. 

KEY WORDS: Current Measurement; Current Transformer; Current Sensor; Rogowski Coil; 

Accuracy Class; deferential protection, saturation 
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1 ÚVOD 
 

Rozsah elektrických veličin v elektrizačních soustavách je velmi rozsáhlý, proto je nutno 

přizpůsobovat příslušné proudy a napětí standardním hodnotám, které jsou vhodné pro měřící, 

jistící a regulační přístroje. Tento požadavek je dán hledisky technickými i ekonomickými. Tyto 

přístroje se do elektrických obvodů nezapojují přímo, ale nepřímo přes přístrojové 

transformátory. Důležitou vlastností proudových transformátorů a senzorů je schopnost 

galvanického oddělení měřených obvodů vysokého napětí od obvodů měřicích a jistících, což 

vede ke zvýšení bezpečnosti obsluhy. Měřicí přístroje jsou pak přehledně umístěny ve velínech 

mimo rozvodny. Podle typu přístroje, který bude v obvodě na transformátor připojen, se pak dělí 

transformátory na měřící a jistící. Na oba typy máme většinou rozdílné požadavky. Přístrojové 

transformátory měřící musí být přesné především v oblastech, které jsou v okolí jmenovité 

hodnoty. Nejsou zde kladeny zvláštní požadavky na rychlost odezvy, tzn. že může nastat i 

dynamické zkreslení přenášené veličiny v přechodném stavu. Naopak přístrojové transformátory 

jistící musí zajišťovat dostatečně přesný přenos i na hranicích pracovní oblasti, tj. při velkých 

nadproudech a minimálních napětích. Stačí zde obvykle menší přesnost než u PT měřících. Dále 

je vyžadována velká rychlost přenosu, tj. přesná transformace přechodného jevu, který se 

objevuje v proudu a napětí objektu při poruše. Výjimku tvoří wattové ochrany a ochrany při 

nesouměrnosti. Jejich požadavky na PT odpovídají požadavkům na měřící transformátory. 

V praxi se často konstruují bloky až čtyř transformátorů, z nichž např. dvě jádra slouží pro 

ochrany, jedno pro regulátory, a jedno pro měřicí přístroje. [1] 

Problematika vypnutí poruchy transformátorů se dostává do popředí s rostoucími 

pořizovacími cenami transformátorů. Pokud totiž nedojde k včasné identifikaci poruchy a po té k 

včasnému odepnutí transformátoru od zdrojů energie, může dojít k tak velké destrukci, že oprava 

transformátoru již nebude možná. Dnešní tržní prostředí vyžaduje od zařízení vyšší využití, což 

vede k přetěžování transformátorů a jejich rychlejšímu stárnutí. 

Na druhé straně výpadek transformátoru způsobený nadbytečným působením ochran také 

vede k velkým finančním ztrátám, zvláště v dnešní době, kdy průmyslová výroba je 

automatizována a řízena průmyslovými počítači. Obdobný stav je v nevýrobní sféře, například v 

bankovnictví, kde výpadek elektrické může způsobit nemalé finanční ztráty, ve zdravotnictví 

mohou dokonce nastat ztráty na životech. [12] 

Hlavním cílem této diplomové práce je prozkoumat princip a vlastnosti přístrojových 

transformátorů a proudových senzorů, konfigurace a nastavení rozdílové ochrany REF542plus 

pro chránění transformátoru a její testování s použitím přístrojových transformátorů proudů a 

proudových senzorů.  
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2 CHARAKTERISTIKA SOUČASNÉHO STAVU MĚŘENÍ 

PROUDŮ 
 

Pro měření proudů v energetických sítích se dosud běžně používají proudové transformátory 

s magnetickým jádrem. Měřící transformátory proudu patří zřejmě k nejrozšířenějším 

převodníkům pro měření velkých střídavých proudů. Proudové transformátory však mají několik 

podstatných nevýhod. Nejvýznamnější je nelinearita magnetizační charakteristiky (tzn. závislost 

magnetické indukce B na intenzitě magnetického pole H) feromagnetickým materiálů 

používaných pro výrobu magnetických obvodů. Při určité úrovni intenzity magnetické pole 

(a tedy při určité velikosti měřeného proudu) dojde k tzv. stavu nasycení, kdy se zásadně změní 

vlastnosti feromagnetika a magnetizační charakteristika se od svého původního lineárního 

průběhu výrazně odkloní. Pro zajištění potřebného rozsahu linearity je nutné dostatečně 

dimenzovat průřez magnetického obvodu proudového transformátoru. Tím však značně narostou 

jeho rozměry a hmotnost. Pro omezení vlivu ztrát vířivými proudy musí být navíc jádro sestaveno 

z listů feromagnetického materiálů, tím se komplikuje a prodražuje výroba celého proudového 

transformátoru. 

Všechny uvedené obecné nevýhody měřících transformátorů proudu se při jejich použití 

v jistících přístrojích projevují zvlášť citelně. Z hlediska chránění je velmi nepříjemné, že 

k nasycení feromagnetického jádra proudového transformátoru dochází v oblasti velkých proudů, 

tedy právě v oblasti poruchových proudů, jejichž velikost by měla být měřená a vyhodnocována 

co nejpřesněji. Ani přídavné oteplení způsobené hysterezními ztrátami a ztrátami vířivými proudy 

nemusí být vždy zanedbatelné. 

Naopak u přístrojových transformátorů používaných pouze k měřícím účelům je nasycení 

jádra pozitivní. Vlivem přesycení se totiž omezí sekundární proud a tím jsou chráněná citlivá a 

přesná měřící zařízení, nebo elektroměry před účinky vysokých proudů.[2] 

Novým řešením pro měření proudů, nutných pro ochranu a monitorování v systémech 

vysokého napětí, jsou proudové senzory. Senzory, založené na alternativních principech měření, 

jsou nástupci klasických měřicích transformátorů s cílem snížit velikost, zlepšit výkonnostní 

parametry a zajistil vyšší stupeň standardizace. Tyto principy nejsou zdaleka nové, avšak teprve 

nyní, díky postupnému rozšíření použití inteligentních elektronických ochran, je možné plně 

využít výhodných vlastností těchto principů. 

Proud v senzoru je měřen na principu Rogowského cívky (Rogowski coil). Rogowského 

cívka je toroidní cívka bez želeného jádra, umístěná kolem primárního vodiče stejným způsobem, 

jako sekundární vinutí transformátoru proudu.[4] Zásadně se však liší vlastnosti obou 

převodníků. Díky absenci magnetického jádra nemá proudový senzor žádnou z nevýhod 

proudových transformátorů. Protože proudové senzory nemají magnetické jádro, které by mohlo 

být nasyceno, zůstává měřicí rozsah lineární i pro velké proudy. Výstupním signálem 

Rogowského cívky však není proud, nýbrž napětí.[3] 
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3 PŘÍSTROJOVÉ TRANSFORMÁTORY PROUDU 
 

Požadavky na měření elektrických veličin chráněného objektu jsou značně náročné. Běžně se 

vyskytují proudy řádu jednotek kiloampérů a napětí řadu stovek kilovoltů. Proto se ochrana 

nezapojuje do obvodů přímo, ale přes přístrojové transformátory proudu a napětí. 

Smysl použití přístrojových transformátorů můžeme shrnout v následujících bodech: 

 

a) Transformují jmenovité proudy a napětí objektu na jednotné velikosti určené 

normou, tj.100V, 5 A nebo 1 A pro vstup ochran. 

b) Izolují obvody vn a vvn od obvodů ochrany. Tak je zajištěna bezpečnost obsluhy i 

ochrany. 

c) Umožňují umístnit ochrany z dosahu rušivých magnetických a elektrických polí 

objektu. 

d) Dovolují sčítat nebo odečítat proudy a napětí z několika izolovaných objektů. 

e) Dovolují soustředit ochrany v dozornách, tj. v prostorech, kde je přehledně 

umístěno řízení celého objektu. 

f) V případech, kde ochrana nemusí po překročení nastavené hodnoty dostávat 

přesnou informaci, může přístrojový transformátor omezovat sekundární veličiny při 

poruchových stavech (např. při velkých nadproudech) a tak chránit vstupní obvody 

ochrany. Jedná se např. o některé nadproudové ochrany, ne však o ochrany rozdílové a 

distanční.[5] 

3.1 Parametry přístrojových transformátorů proudů 

 

Jmenovitý primární proud I1N – efektivní hodnota primárního proudu, která je uvedena na 

štítku transformátoru a na které je založena jeho činnost. Normalizované hodnoty jmenovitých 

primárních proudů jsou 10 – 12,5 – 15 – 20 – 25 – 30 – 40 – 50 – 60 – 75 A a jejich dekadické 

násobky nebo zlomky  

 

Jmenovitý sekundární proud I2N – efektivní hodnota sekundárního proudu, která je uvedena na 

štítku transformátoru a na které je založena jeho činnost. Normalizované hodnoty jmenovitých 

sekundárních proudů jsou 1 A, 2 A a 5 A.  

 

Jmenovitý převod kI – poměr jmenovitého primárního proudu k jmenovitému sekundárnímu 

proudu  

NNI IIk 21           ( 3.1 ) 
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Břemeno Z – celková impedance přístrojů připojených na sekundární svorky transformátoru při 

daném účiníku  

 

Jmenovité břemeno ZN – impedance, kterou smí být přístrojový transformátor zatížený, aby byla 

dodržena předepsaná přesnost  

 

Zátěž SN – hodnota zátěže ve VA, na které jsou založeny požadavky na předepsanou přesnost. 

Řada standardně vyráběných jmenovitých výkonů 2,5 – 5 – 10 – 15 – 30 VA.  

 

Chyba proudu – rozdíl mezi jmenovitým a předpokládaným sekundárním proudem. 

(%)100
1

12 



I

IIk I
I          ( 3.2 ) 

 

Chyba úhlu φ – fázový rozdíl mezi fázory primárního a sekundárního proudu Chyba úhlu se 

považuje za kladnou, jestliže fázor sekundárního proudu předchází fázor primárního proudu. 

 

Jmenovitý kmitočet fN- hodnota kmitočtu, ze které jsou odvozeny požadavky norem 

 

Celková chyba – efektivní hodnota rozdílu mezi okamžitými hodnotami primárního proudu a 

okamžitými hodnotami skutečného sekundárního přepočtené na primární stranu 

  

T

Ic dtiik
T

0

2

12

1
          ( 3.3 ) 

 

Nejvyšší napětí pro zařízení – nejvyšší efektivní hodnota sdruženého střídavého napětí pro 

kterou je transformátor konstruován s ohledem na jeho izolaci  

 

Jmenovitý krátkodobý tepelný proud - efektivní hodnota primárního proudu, který 

transformátor vydrží po dobu 1 sekundy při zkratovaném sekundárním vinutí, aniž by došlo k 

poškození transformátoru  

 

Jmenovitý dynamický proud – vrcholová hodnota primárního proudu, kterou transformátor 

vydrží bez elektrického nebo mechanického poškození elektrodynamickými silami při 

zkratovaném sekundárním vinutí  

 

Jmenovitý primární nadproud – hodnota minimálního primárního proudu, při které je celková 

chyba měřicího transformátoru proudu rovna nebo větší než 10 % při jmenovitém sekundárním 

břemeni  
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Nadproudové číslo – poměr jmenovitého primárního nadproudu ke jmenovitému primárnímu 

proudu. Možnosti provedení jsou 5 ; 10 ; 15 ; 20 ; 30 

 

Třída přesnosti PTP - označení přiřazené transformátoru proudu, jehož chyba proudu a chyba 

úhlu nepřekročí provozní hodnoty v předepsaných provozních podmínkách. Třídy přesnosti 

měřících transformátorů proudu jsou 0,1 ; 0,2 ; 0,5 ; 1 ; 3 ; 5 ; jistících transformátorů proudu 

jsou 5P a 10P a jim odpovídají dovolené chyby:  

 

Tabulka 3-1 Dovolené chyby proudu a úhlu pro měřicí transformátory proudu [9] 

Třída 
přesnosti   

±Chyba proudu v 
procentech 

jmenovitého proudu 

±Chyba úhlu v procentech jmenovitého proudu 

Minuty Centiradiány 

In[%] 5 20 100 120 5 20 100 120 5 20 100 120 

0,1   0,4 0,2 0,1 0,1 15 8 5 5 0,45 0,24 0,15 0,1 

0,2   0,75 0,35 0,2 0,2 30 15 10 10 0,9 0,45 0,3 0,3 

0,5   1,5 0,75 0,5 0,5 90 45 30 30 2,7 1,35 0,9 0,9 

1,0   3 1,5 1,0 1,0 180 90 60 60 5,4 2,7 1,8 1,8 

 

Tabulka 3-2 Dovolené chyby pro jistící transformátory proudu [9] 

Třída 
přesnosti 

Chyba proudu v % 
jmenovitém primárním 

proudu 

Chyba úhlu při jmenovitém 
primárním proudu 

Celková chyba v % při 
jmenovitém primárním 

nadproudu Minuty Centiradiány 

5P 1 60 1,8 5 

10P 3 - - 10 

 

  



  3 PŘÍSTROJOVÉ TRANSFORMÁTORY PROUDU 

 

19 

3.2 Přístrojové transformátory proudu  

 

Přístrojový transformátor proudu musí zaručit konstantní poměr výstupního a vstupního 

proudu. Vstupní vinutí je zapojeno do série s obvody chráněného objektu. Primární vinutí je 

obvykle tvořeno jediným závitem. K sekundárnímu vinutí jsou připojeny měřicí a jistící přístroje. 

Primární svorky se standardně označují velkými písmeny, sekundární svorky malými písmeny 

 

 

Obrázek 3.1 Zapojení přístrojového transformátoru do obvodu 

 

 Hlavním znakem PTP je, že jeho výstupní proud 2I  je dán vstupním obvodem, ve kterém 

je PTP zapojen. Obrázek 3.1 značí: 

 1I  je vstupní proud, 

 2I  výstupní proud, 

 aX  reaktance obvodu chráněného objektu, 

 aR  činný odpor obvodu chráněného objektu, 

 bZ  vnější břemeno transformátoru. 

 

Činnost transformátoru je založena na principu elektromagnetické indukce. Průchodem proudu 

primárním vinutím se v jádře transformátoru vybudí magnetický tok Φ, který indukuje proud v 

sekundárním vinutí. 

2211~ NNNN ININ            ( 3.4 ) 
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kde  1NN   je počet závitů vstupního vinutí, 

  2NN   počet závitů výstupního vinutí, 

Ik  jmenovitý převod PTP. 

Napětí na výstupní straně je dáno zatížením PTP 

22 IZU b            ( 3.6 ) 

Proto nesmí nikdy dojít k rozpojení výstupního proudového obvodu PTP. Výstupní napětí by 

vzrostlo a mohlo by ohrozit ochranu, obsluhu i samotný PTP, neboť  2UZb . 

Znamená to, že na výstupní straně se objeví špičkové napětí, které je tím vyšší, čím ostřejší je 

koleno magnetizační charakteristiky transformátoru. Aby bylo možné zkoušet proudové obvody 

ochran za provozu, musí být vybaveny zvláštní zkratovací zásuvkou, která zkratuje proudové 

obvody PTP během zkoušení.  

 

3.3 Provoz přístrojových transformátorů proudů 

 

 

3.3.1 Chyba proudu  

 

Na Obrázek 3.2 je náhradní schéma obvodu z Obrázek 3.1. Vzhledem k velikosti aR  a aL  

objektu lze rozptyl na vstupní straně a odpor PTP zanedbat. Z náhradního schématu vyplývá, že 

transformátor proudu je zatížen chybou proudu, která je způsobena magnetizačním proudem 0I .  

(%)100

1

12





I

IIk I

I         ( 3.7 ) 

kde 1I  je vstupní proud, 

  2I  výstupní proud 

La Lb ΣRb 

Rm Lm 

I1 I2 

I0 Ra 

Zb 

Z0 

Obrázek 3.2 Náhradní schéma přístrojového transformátoru proudu 
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3.3.2 Chybu úhlu  

1

Im

180 I

I
tgstrad


 


         ( 3.8 ) 

kde IIm  je imaginární složka rozdílu proudu 21 III   

 

Obě chyby PTP zvětšují se zatížením transformátoru, tj. se zvětšováním bZ . Proto musí mít 

impedance sekundárního obvodu co nejnižší hodnotu. Naopak, čím má PTP větší příčnou 

impedanci 0Z , tím je přesnější. Z toho důvodu je nutný dostatečný průřez magnetického jádra z 

kvalitního feromagnetického materiálu  

Proto je důležité, aby celková spotřeba všech přístrojů připojených do sekundárního obvodu 

transformátoru nepřekročila dovolené zatížení. Pokud tuto hodnotu překročíme, přestane 

transformátor pracovat v blízkosti stavu nakrátko. Dojde ke změně jeho skutečného převodu a při 

měření proudu vznikne značná chyba. [8] 

3.3.3 Magnetické vlastnosti jádra 

 

Základní vlastností feromagnetických materiálů je možnost vybudit v nich i poměrně slabým 

magnetickým polem velmi silnou magnetizaci. Poněvadž je velikost jádra PTP konečná, dochází 

k jeho nasycení a na magnetizační charakteristice )( ms IfE   se objeví nelinearita Obrázek 3.3. 

Bod K na magnetizační charakteristice nazýváme bod nasycení. 

 

  

Obrázek 3.3 Magnetizační charakteristika přístrojového transformátoru proudu 
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Koleno magnetizační charakteristiky je definováno jako bod, ve kterém zvětšení napětí sE  o 

10% způsobení zvětšení magnetizačního proudu mI  o 50 %. Za kolenem charakteristiky 

mluvíme o nasycení PTP. V této oblasti téměř všechen vstupní proud musí přejít na 

magnetizační. 

Transformátory proudu jsou konstruovány tak, aby do hodnoty jmenovitého primárního 

proudu zůstaly lineární a měly zaručenou přesnost. Vlivem saturace dochází ke zkreslení 

výstupních hodnot, což je příčinou chyby měření nebo nesprávné funkce ochranných zařízení. 

Tvar magnetizační charakteristiky a poloha kolena K závisí na materiálu jádra, jeho průřezu a 

délce střední silové čáry. Pro zvýhodnění těchto parametrů a zmenšení rozptylu se PTP vinou 

zpravidla jako toroidní. 

U PTP při zvětšování břemene bZ  roste napětí bU  podle vztahu (3.6). Vzrůst tohoto napětí 

je omezen velkostí limU . Jakmile napětí bU  dosáhne hodnoty limU , dojde k nasycení PTP, rychle 

se zvětší chyba a při souměrném vstupním proudu dojde ke zkreslení výstupního proudu. 

Nasycením je proto omezen výkon, tj. jmenovitá zátěž PTP. 

 

3.4 Zapojení PTP 

 

PTP jsou konstrukčně vyhotovené jako jednofázové, v trojfázové soustavě se používají dva 

nebo tři transformátory, podle druhu ochrany.  

3.4.1 Způsoby zapojení PTP do obvodů napájení ochran: 

 Do úplné hvězdy – toto zapojení se používá v účinně uzemněných soustavách (zemní 

spojení)  

 Do neúplné hvězdy – toto zapojení se používá v neúčinně uzemněných soustavách 

(zkraty). Zapojení do neúplné hvězdy znamená zapojení 2 rozběhových členů, jedna 

fáze se vynechává.  

 Do trojúhelníka – toto zapojení se používá pro rozdílové ochrany. Rozběhové členy 

ochran připojené na vinutí trojúhelníka reagují na všechny typy zkratů.  

 Součtové zapojení – využití pro ochrany vedení. Součtové zapojení znamená spojení 

sek. vinutí transformátorů do jednoho rozběhového členu ochrany. 80[12] 

3.4.2 Převod a hodinový úhel: 

Elektromechanické diferenciální ochrany dovedou porovnat jen stejné proudy a stejný fázový 

úhel. Aby mohly pracovat, musí se zvolit vhodné zapojení a vhodné měniče. Při chránění 

transformátorů v zapojení Y/D musí dojít k převodu hodinového úhlu. Skupina jistících 

transformátorů na jedné straně má zapojení sekundárních vinutí stejné jako silový transformátor 

na straně protější. Spojení sekundárních vinutí transformátorů proudu je tedy zrcadlovým 

obrazem spojení vinutí silového transformátoru. Pro správnou funkci se ale strana zapojená do 

trojúhelníku nesmí přizemnit. Převod transformátorů se musí vhodně zvolit tak, aby nebyly za 

normálního bezporuchového stavu diference. [13] 
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Obrázek 3.4 Vyrovnání hodinového úhlu při zapojení Y/D [17] 

 

3.5 Dělení transformátorů proudu 

 

Transformátory proudu lze dělit podle několika hledisek. Podle konstrukčního provedení, 

podle tvaru primárního vinutí, podle magnetického obvodu nebo podle způsobu použití. 

 Podle konstrukčního provedení je lze rozdělit na podpěrné, průchodkové nebo průchozí 

 podle tvaru primárního vinutí na jednozávitové, závitové, smyčkové, tyčové, násuvné, 

prstencové 

 podle magnetického obvodu je dělíme na jednojádrové, vícejádrové, kaskádové, sčítací, 

nízkoreaktační a vyskoreaktační 

 Podle způsobu použití transformátory proudu lze rozdělit na měřící a jistící. Na oba druhy 

jsou kladeny rozdílné požadavky, což vyplívá z podmínek, za kterých mají správně 

pracovat. 
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3.5.1 Provedení přístrojových transformátorů proudu  

Přístrojové transformátory proudu jsou zalévané do epoxidové pryskyřice, která tvoří izolaci pro 

různé hodnoty napětí. Počet sekundárních vinutí se pohybuje od 1 do 6 a závisí na kombinaci 

technických parametrů, jako je třída přesnosti, impedance zátěže, velikost zkratového proudu, 

nadproudový činitel, rozměry transformátoru a jiné. Sekundární vinutí jsou používána pro měřicí 

nebo jistící účely, případně pro zvláštní použití. Během provozu musí být jedna svorka každého 

použitého vinutí uzemněna. Nepoužitá vinutí musí být zkratována a uzemněna. [14] 

 

3.5.1.1 Podpěrné transformátory proudu  

Podpěrné transformátory mají primární svorky umístěné na temeni tělesa. Sekundární svorky 

jsou umístěny na čelní straně. Spodní část tělesa je uchycena šrouby k rámu rozvaděče, případně 

k podlaze kobky. Transformátory jsou navrženy buď jako jednozávitové, pro jmenovité proudy 

od 400 A do 3200 A, nebo s větším počtem závitů na primární straně pro jmenovité proudy od 10 

A do 600 A. Mohou mít až dva převody s možností přepínání na primární, nebo sekundární 

straně. Na Obrázek 3.5 je znázorněno schéma a skutečné provedení podpěrného transformátoru 

proudu. 

 

Obrázek 3.5 Provedení podpěrného transformátoru proudu 

3.5.1.2 Tyčové transformátory proudu  

Tento typ transformátoru má vestavěný vodič ve tvaru pásu, který představuje primární 

vinutí. Tyčové transformátory mohou mít více převodů s přepínáním na sekundární straně. Při 

instalaci do rozvaděče jsou tyto transformátory využívány jako průchodky. Jmenovité primární 

proudy jsou v rozmezí od 100 A do 2500 A. Na Obrázek 3.6 je znázorněno schéma a skutečné 

provedené tyčového transformátoru proudu. 

 

Obrázek 3.6 Provedení tyčového transformátoru proudu 
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3.5.1.3 Násuvné transformátory proudu  

Násuvné transformátory proudu se liší od předchozích transformátorů tím, že nemají 

vestavěné primární vinutí, které je v tomto případě tvořeno rovnou přípojnicí. Takový 

transformátor je vybaven pouze magnetickým obvodem s navinutým sekundárním vinutím. Na 

přípojnici, ve které chceme měřit proud, se nasouvá. Tyto transformátory se používají pro měření 

proudů do hodnoty 6000 A. Při proudech větších než 4000 A jsou jádra transformátoru chráněna 

před působením magnetických polí sousedních přípojnic.  

Prakticky stejným způsobem funguje prstencové provedení s tím rozdílem, že jádro nemá 

čtvercový, ale prstencový tvar a sekundární vinutí je rovnoměrně rozloženo po celém obvodu. Na 

Obrázek 3.7 je znázorněno schéma a skutečné provedené násuvného transformátoru proudu. 

 

Obrázek 3.7 Provedení násuvného transformátoru proudu 

3.5.1.4 Průchodkové transformátory proudu  

Tyto transformátory pracují na stejném principu jako transformátory násuvné. 

Svou konstrukcí jsou uzpůsobené jako průchodky. Transformátory tohoto typu se používají v 

rozvodných zařízeních vysokého napětí se jmenovitými proudy do 5000 A. Transformátory mají 

násuvnou konstrukci s jedním až třemi sekundárními vinutími podle typu použití. Vnitřní otvor je 

opatřen polovodivým nátěrem, který je vyveden na čelní plochu tělesa a za provozu je propojen s 

primárním vodičem. Provedení takového transformátoru proudu je na Obrázek 3.8. 

 

Obrázek 3.8 Provedení průchodkového transformátoru proudu 
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3.6 Elektronické transformátory proudu malého výkonu (LPCT)  

 

Transformátory proudu malého výkonu založené na cívkách se železným jádrem představují 

další vývoj klasických induktivních transformátorů proudu. Protože moderní elektrické přístroje 

vyžadují malý vstupní výkon, mohou být LPCT dimenzovány pro velké impedance Důsledkem 

toho je omezení vlivu saturace jádra, což je hlavní nevýhoda klasických transformátorů proudu, a 

tím je značně rozšířen měřicí rozsah.  

Snížením celkové spotřeby je umožněno měření nadproudů i zkratových proudů s vysokou 

přesností. Přes široký měřicí rozsah mohou být LPCT konstruovány s menšími rozměry než 

klasické transformátory srovnatelných parametrů. S rozšířením měřicího rozsahu odpadá dělení 

klasických transformátorů na měřicí a jistící, protože pro oba účely lze použít jediný elektronický 

transformátor malého výkonu. 80[10] 

3.6.1 Princip elektronických transformátorů malého výkonu  

 

LPCT se skládají z transformátoru proudu s primárním vinutím, malým magnetickým jádrem 

a sekundárním vinutím s minimalizovanými ztrátami. Sekundární obvod je uzavřen 

bočníkem shR . Tento bočník je součástí LPCT a je velmi důležitý pro funkci a kalibraci 

transformátoru.  

Odpor bočníku je navržen tak, aby spotřeba výkonu pro transformátor byla blízká nule. 

Sekundární proud 2I  způsobuje úbytek napětí sU  na bočníku, který je úměrný primárnímu 

proudu v amplitudě a fázi. Výstupním signálem z LPCT je úbytek napětí na bočníku shR . 

LPCT se tak stává ideálním z hlediska měřicího rozsahu, přesnosti a menších vnitřních ztrát. 

Princip funkce je znázorněn na Obrázek 3.9. Výstupní napětí je určeno vztahem: [10] 

1

2

1 I
N

N
RU shs            ( 3.9 ) 

 

Obrázek 3.9 Princip funkce elektronického transformátoru malého výkonu [10] 
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4 PROUDOVÉ SENZORY  
 

Modernějším řešením měření proudů a napětí pro jištění a monitorování v energetických 

systémech vysokého napětí se staly proudové senzory. Proudové senzory byly zavedeny jako 

následovníci klasických transformátorů proudu. Hnací silou v jejich vývoji byla nutnost 

standardizovat a optimalizovat výrobu rozvaděčů vysokého napětí, ve kterých jsou alternativou 

ke klasickým přístrojovým transformátorům proudu.  

4.1 Definice důležitých pojmů  

Pro další popis proudových senzorů je nutné definovat pojmy, které charakterizují základní 

veličiny a vlastnosti. [10] 

 

Elektronický přístrojový transformátor - uspořádání jednoho nebo více proudových senzorů, 

které mohou být zapojeny do přenosového systému a sekundárních převodníků; toto uspořádání 

je určeno k převodu měřené veličiny pro měřicí přístroje, elektroměry a ochrany nebo řídící 

zařízení  

 

Elektronický transformátor proudu - elektronický transformátor proudu, u něhož je výstup ze 

sekundárního převodníku za normálních podmínek použití prakticky úměrný primárnímu proudu 

a liší se od něj ve fázi o známý úhel pro příslušné zapojení  

 

Primární svorky - jsou svorky, kterými prochází měřený proud  

 

Primární proudový senzor - elektrické, optické nebo jiné zařízení určené k přenosu signálu 

odpovídajícímu proudu, který protéká přes primární svorky do sekundárního převodníku přímo, 

nebo přes primární převodník  

 

Primární převodník - uspořádání, které přeměňuje signál, přicházející z jednoho nebo více 

primárních senzorů na signál vhodný pro přenosový systém  

 

Přenosový systém - vazební uspořádání na vzdálenost mezi primárními a sekundárními částmi 

určenými k přenosu systému  

 

Sekundární převodník - uspořádání, které mění signál vyslaný přes vysílací systém na veličinu 

úměrnou proudu mezi primárními svorkami pro napájení měřicích přístrojů, elektroměrů, jistících 

nebo řídících zařízení  

 

Sekundární obvod - vnější obvod, který získává informační signály ze sekundárního převodníku 

elektronického přístrojového transformátoru  
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Jmenovitý kmitočet - hodnota základního kmitočtu, na které jsou založeny požadavky normy  

 

Jmenovitý primární proud Ipr - efektivní hodnota složky primárního proudu při jmenovitém 

kmitočtu, na kterém je založeno provedení elektronického transformátoru proudu 

 

Jmenovitý sekundární výstup Usr - pro analogový výstup je to efektivní hodnota sekundárního 

napětí při jmenovitém kmitočtu, na které je založena činnost elektronického transformátoru 

proudu  

 

Jmenovitý převod elektronického transformátoru Kra - jmenovitá hodnota převodu  

 

Skutečný převod elektronického transformátoru Ka - pro analogový výstup je to poměr 

skutečné efektivní hodnoty primárního proudu ke skutečné efektivní hodnotě sekundárního 

výstupu elektronického transformátoru proudu  

 

Chyba převodu % : je chyba, kterou elektronický transformátor proudu vnáší do měření 

proudu, a která vyplývá ze skutečnosti, že skutečný převod se liší od jmenovitého  

Pro analogový výstup bude chyba proudu v procentech dána vztahem:  

100% 



p

psra

I

IUK
 (%)         ( 4.1 ) 

 

Chyba úhlu φ - pro analogový výstup je to rozdíl fáze mezi fázory primárního a sekundárního 

proudu; orientace fázorů je zvolena tak, aby se úhel rovnal jeho jmenovité hodnotě při 

jmenovitém kmitočtu u ideálního elektronického transformátoru; chyba úhlu se považuje za 

kladnou, když fázor sekundárního výstupu předchází fázor primárního proudu; chyba úhlu se 

vyjadřuje v minutách nebo centiradiánech  

 

Třída přesnosti: označení přiřazené elektronickému transformátoru proudu, jehož chyba proudu 

a úhlu nepřekročí povolené mezní hodnoty v předepsaných provozních podmínkách  

 

Nejvyšší napětí pro zařízení Um - nejvyšší efektivní hodnota sdruženého napětí, pro které je 

elektronický transformátor proudu konstruován s ohledem na jeho izolaci  

 

Jmenovitá izolační hladina: kombinace hodnot napětí, která charakterizuje izolaci z hlediska jeho 

schopnosti odolávat elektrickému namáhání  

 

Proud pro vybavení: nejmenší efektivní hodnota primárního proudu nezbytná pro vybavení 

elektronického transformátoru proudu  

 

Břemeno: impedance sekundárního obvodu vyjádřená v ohmech při 1cos   
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Jmenovité břemeno Rbr - hodnota břemena, na kterou jsou založeny požadavky na předepsanou 

přesnost  

 

Jmenovité zpoždění tdr - jmenovitá hodnota času, který je potřebný pro zpracování údajů a jejich 

přenos  

 

Korekční činitel - chyba proudového senzoru je v celém rozsahu konstantní, a proto ji můžeme 

korigovat korekčním činitelem. Korekční činitel je měřen pro každý senzor samostatně při 

kusových zkouškách. 

4.2 Princip Rogowského cívky: 

 

Rogowského cívka jako měřící prvek měří změny proudu ve sledovaném vodiči díky 

indukovanému napětí ve vodiči cívky. Princip je takový, že střídavý proud sledovaného vodiče 

vytváří kolem sebe střídavé magnetické pole, které způsobí indukci napětí ve vodiči toroidní 

vzduchové (Rogowského) cívky. Výsledné napětí je tak úměrné změně magnetického toku a tedy 

i hodnotě střídavého proudu, který ho vyvolal, jak je znázorněno na Obrázek 4.1. 

 

 

Obrázek 4.1 Princip měření proudu pomocí Rogowského cívky [15] 

Z toho důvodu, že se jedná o cívku bez železného jádra (vzduchovou cívku) je její důležitou 

vlastností to že, nemůže dojít k jakémukoliv nasycení jádra a Rogowského cívka zůstává 

lineárním převodníkem pro libovolně velké proudy.  

Další výhodnou vlastností Rogowského senzoru je skutečnost, že na velikost výstupního 

napětí mají vliv pouze proudy, které obepíná magnetický obvod cívky. Vliv okolních 

elektrických proudů, které neprocházejí cívkou, je potlačen. 

Další důležitým aspektem je přítomnost zpětného vodiče, který prochází podél magnetického 

obvodu cívky. Zpětně vedený vodič zabraňuje vlivu magnetických toků kolmých na rovinu cívky 

senzoru. [15] 

ui(t) 

dt

tdi
I

)(
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Jestliže má jádro konstantní průřez a závity jsou navinuty kolmo k průřezu jádra s konstantní 

hustotou, pak je výstupní napětí definováno rovnicí: 

dt

di
M

dt

di
SNu

tt

rt

)()(

0)(          ( 4.2 ) 

kde 0  je permeabilita vakua 

  r  je relativní permeabilita (permeabilita vzduchu rovna 1), 

  N je počet závitů cívky 

  S je plocha závitu 

 

Výstupní napětí je úměrné derivaci okamžité hodnoty měřeného proudu. V případě 

sinusového proudu je výstupní napětí fázově posunuto o 90 stupňů. Výsledný neintegrovaný 

signál je odlišný od průběhu měřeného proudu, avšak integrací tohoto signálu získáme přesný 

časový průběh měřeného proudu. Integrace výstupního signálu se provádí pomocí pasivních RC 

(rezistor-kondenzátor) integrátorů nebo operačních zesilovačů. V sítích vysokého napětí integrace 

výstupního signálu není vždy prováděna v samotné cívce, ale v připojených zařízeních, což vede 

ke snížení nákladů na výrobu. Na Obrázek 4.2 je náhradní schéma Rogowského cívky. 

 

 

Obrázek 4.2 Náhradní schéma Rogowského cívky [10] 

 

Vinutí cívky je nahrazeno rozptylovou indukčností Ls a odporem Rt, který zahrnuje také 

odpor připojeného kabelu. Odpor Ra je volitelný, je používám pro potřeby kalibrace. Tento odpor 

kompenzuje výrobní tolerance v rozměrech vinutí a v hodnotách počtu závitů. Kapacita Cc 

odpovídá kapacitě připojeného kabelu. Hodnota zatěžovací impedance Rb musí být velká, ideálně 

nekonečná, aby nevznikaly chyby měření vlivem úbytků napětí na vinutí a připojeném kabelu. 

Pro výstupní napětí platí: [10] 
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       ( 4.3 ) 

Pro bR  pak platí 

prsr IMjU             ( 4.4 ) 
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Pro ideální Rogowského cívku je vzájemná indukčnost M nezávislá na umístění vodiče 

uvnitř cívky. K zabránění vlivu blízkých vodičů, kterými tečou velké proudy, musí být 

Rogowského cívka zkonstruována ze dvouvodičových smyček spojených v elektricky opačných 

směrech. Tento způsob odstranění vlivu všech vnějších elektrických polí působících na 

Rogowského cívku je zobrazen na Obrázek 4.3a. Obě smyčky mohou být utvořeny navinutím na 

nemagnetické jádro, nebo druhá smyčka může být utvořena vracejícím se drátem skrz střed vinutí 

první smyčky. Tento způsob je zobrazen na Obrázek 4.1. Jestliže jsou obě smyčky z vinutého 

drátu, musí být druhé vinutí vinuto v opačném směru. V tomto případě napětí indukované v cívce 

je dvojnásobné, jak ukazuje Obrázek 4.3b. [3] 

       

Obrázek 4.3 Výstupní napětí Rogowského cívky pro a) vodič vně, b) uvnitř cívky 

 

4.2.1 Provedení PCB Rogowského cívky  

Tradičně se Rogowského cívky skládají ze dvou vrstev vinutí umístěných na sobě. Nově 

patentovaný způsob konstrukce Rogowského cívky se skládá ze dvou vzájemně propojených 

cívek umístěných blízko sebe, viz Obrázek 4.4. Druhá cívka je vinuta v opačném směru než první 

cívka. 

 

Obrázek 4.4 Princip PCB Rogowského cívky [3] 
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K dosažení ještě větší přesnosti bylo dosaženo použitím dvou samostatných PCB cívek 

umístěných blízko sebe, viz Obrázek 4.5. Cívky jsou vinuty v opačných směrech (pravotočivě a 

levotočivě). Vrchní a spodní strana desky plošných spojů je vtisknuta do formy. První cívka má 

pravotočivý smysl a pokračuje ve směru hodinových ručiček okolo středu desky. Druhá cívka je 

umístěna stejným způsobem s rozdílem levotočivého vinutí. [3] 

 

 

Obrázek 4.5 Princip Rogowského cívky využívající dvou PCB cívek [3] 

 

PCB Rogowského cívky mohou být provedeny v různých tvarech, aby se mohly přizpůsobit 

konkrétnímu použití. Mohou být také vyrobeny s děleným jádrem pro instalaci bez nutnosti 

přerušení měřeného vodiče. Na Obrázek 4.6 je znázorněn oválný tvar Rogowského cívky s 

děleným jádrem, které umožňuje obejmout trojfázové vodiče pro měření rozdílových proudů, 

nebo více paralelních vodičů. V tomto případě je jádro rozděleno na čtyři části. První dvě části 

jsou zkonstruovány se dvěma PCB cívkami s vinutími navinutými v opačném směru. [3] 

 

 

Obrázek 4.6 PCB Rogowského cívka s děleným jádrem [3] 
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Konstrukce PCB Rogowského cívek k měření fázových a zemních proudů je znázorněna na 

Obrázek 3.7. Jedná se o čtyři samostatné cívky zabudované v jednom rámu. Tři cívky měří 

fázové proudy tekoucí jednotlivými vodiči a čtvrtá cívka pro měření rozdílových proudů, které 

vznikají v případě poruchy některé fáze. [3] 

 

 

Obrázek 4.7 Princip konstrukce PCB cívek pro měření fázových a rozdílových proudů 

4.3 Vlastnosti proudových senzorů  

 

Použitím Rogowského cívek získávají proudové senzory řadu výhodných vlastností, díky 

kterým nacházejí nové možnosti využití.  

Následující technická data jsou založena na přehledu komerčně používaných proudových 

senzorů. Ve většině případů použití, se proudový senzor skládá z měřicí hlavy a připojovacího 

kabelu, případně i zabudovaného integrátoru. Druh a délka použitého kabelu mají vliv na 

celkovou přesnost proudového senzoru. Z tohoto důvodu musí být přesnost každého senzoru 

zkoušena společně s daným kabelem, který nesmí být nahrazen jiným typem kabelu.  

Proudové senzory mají tyto typické vlastnosti: [16] 

- Lineární proudový rozsah: Proudové senzory mají velmi široký rozsah proudů, které jsou 

schopny změřit. V současnosti jsou k dispozici senzory s rozsahy od 30 A do 100 kA. Maximální 

hodnota proudového rozsahu je ovlivněna frekvencí a amplitudou měřeného proudu. Nejnižší a 

nevyšší hodnota závisí především na použité měřicí technice.  

Díky absenci magnetického jádra je zaručena linearita měření v celém proudovém rozsahu. 

Chyba proudového senzoru je v celém rozsahu lineární a je způsobena reaktancí vinutí, 

výrobními odchylkami ve vinutí a průřezu jádra a také velikostí zesílení integrátoru.  

- Přesnost měření: Pokud je jádro a vinutí vyrobeno pečlivě, celková přesnost proudového 

senzoru může dosáhnout 0,5% pro rozvaděče vysokého napětí. Největšími zdroji nepřesností jsou 

teplotní změny, výrobní tolerance a vliv ostatních vodičů. Výrobní tolerance v rozměrech vinutí a 

počtu závitů mohou být kompenzovány kalibračními rezistory, nebo použitím korekčního 

činitele, který je uveden na štítku senzoru. Korekční činitel je měřen pro každý senzor samostatně 

při kusových zkouškách. 

  

výstupní konektor cívka pro měření rozdílových proudů 

cívky pro měření fázových proudů 

B A C 
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Dále projevují senzory závislost přesnosti na umístění měřeného vodiče uvnitř měřicí hlavy. 

Senzory s děleným jádrem vykazují maximální chybu v místě rozdělení jádra. Tato chyba může 

dosáhnout hodnot od ±1% do ±4%. Závislost přesnosti na umístění vodiče uvnitř měřicí hlavy 

může být minimalizována pečlivým návrhem a použitou technologií výroby. 

- Kmitočtový rozsah: Pro praktické účely jsou proudové senzory vyráběny pro kmitočty 

50 Hz a 60 Hz. Jsou však použitelné pro kmitočty od jednotek Hz po stovky kHz.  

- Výstupní signál: Běžně používané proudové senzory poskytují bezpečné výstupní napětí, 

které je typicky vyjádřeno jako citlivost v rozmezí od 0,01 mV/A do 200 mV/A. Rozsah 

výstupního napětí se pohybuje od 200 mV do 10 V podle typu senzoru.  

- Teplotní závislost: Většina používaných senzorů má vymezený teplotní rozsah zvlášť pro 

měřicí hlavu a integrační elektroniku. Pro použití mimo uvedený teplotní rozsah se používá 

speciálních úprav měřicí hlavy nebo speciální kalibrace. Teplotní závislost měřicí hlavy je 

způsobena roztažností závitů, roztažností jádra cívky a teplotní závislostí vinutí cívky.  

- Elektromagnetická kompatibilita: Velký vliv na přesnost proudových senzorů mají vnější 

magnetická pole, která pocházejí od ostatních vodičů v blízkosti umístění senzoru. Vliv těchto 

vodičů je závislý na vzdálenosti od senzoru a také na velikosti proudu, který protéká vodičem. 

Problémy mohou nastat v prostředích rozvaděčů vysokého napětí, pokud není vliv vnějších 

magnetických polí zahrnut do návrhu a provedení proudových senzorů. 

4.4 Použití proudových senzorů  

 

Velké množství různých tvarů a velikostí umožňuje použití proudových senzorů v řadě 

různých aplikací. Jejich kompaktní rozměry a nízká hmotnost umožňují snadnou manipulaci a 

instalaci v místě potřeby. Proudové senzory našly své využití pro měření a jištění zařízení, ve 

kterých není možné použít klasické proudové transformátory. Proudové senzory mohou 

nahrazovat rozměrné klasické transformátory proudu v rozvaděčích vysokého napětí. S velkou 

výhodou se používají s diferenciálními ochranami strojů, kterými tečou značné proudy.  

Typickým příkladem takového použití je chránění transformátorů obloukových pecí, velkých 

generátorů a motorů. Případným poškozením takového stroje vlivem špatného působení ochran 

vznikají značné finanční náklady. U transformátorů obloukových pecí je obvykle nadproudová 

ochrana použita na primární straně, protože měření proudů na sekundární straně je značně 

obtížné. Hodnoty proudu na sekundární straně běžně dosahují hodnot desítek kiloampér, což 

vyžaduje značné průřezy několika vodičů, které bývají chlazeny vodou. Případná porucha na 

sekundární straně nebývá ochranou zachycena a obvykle se vypíná manuálně obsluhou pece. 

Použitím ochran, které jsou napájeny proudovými senzory na primární i sekundární straně 

můžeme dosáhnout spolehlivého chránění. [3] 
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4.5 Provedení proudových senzorů  

 

Jak již bylo uvedeno, proudové senzory se vyrábějí pro velice rozličné aplikace. To má za 

následek množství různých konstrukcí senzorů, aby bylo dosaženo optimálních vlastností pro 

jednotlivá použití. 

Jako první se proudové senzory začaly vyrábět pro běžné měřicí a jistící použití. Jedná se o 

senzory vyráběné firmou ABB. Provedení takového senzoru je na Obrázek 4.8a. Dalším vývojem 

byly senzory přizpůsobené pro použití v rozvaděčích vysokého napětí, ve kterých jsou složité 

podmínky z hlediska ovlivňování vnějšími magnetickými poli. Tento typ senzoru je zobrazen na 

Obrázek 4.8b. Tyto senzory pro vnitřní použití mají malé rozměry a hmotnost jen několik 

kilogramů. 

 

 

Obrázek 4.8 Provedení proudových senzorů pro vnitřní použití [14] 

 

Dále vyráběnými senzory jsou kombinované senzory proudu a napětí. Tyto senzory jsou 

rovněž pro vysoké napětí vnitřního použití. Příklad provedení tohoto transformátoru je na 

Obrázek 4.9. Na první pohled, je svým provedením velmi podobný klasickému transformátoru 

proudu podpěrného provedení. Liší se však připojeným kabelem, se kterým je proudový senzor 

podroben zkouškám přesnosti. 

 

Obrázek 4.9 Schéma a provedení kombinovaného senzoru 

Další provedení senzorů firmy ABB je zobrazeno v Příloha A. 

a) b) 
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5 PORUCHY TRANSFORMÁTORŮ 
 

Vzhledem k místu poruchy vůči transformátoru se poruchy dělí na průchozí a vnitřní. 

5.1 Průchozí poruchy 

 

Průchozí poruchy jsou ty, které nastávají vlivem připojených zařízení. Patří sem přetížení, 

nebo vnější zkrat na připojením objektu. Obě poruchy působí většinou delší dobu a způsobují 

zvýšení teploty. Pro přetížení se projektuje zvláštní ochrana, při vnějším zkratu působí 

nadproudová ochrana. 

Přetížení je průchod příliš velké energie transformátorem, teplota vinutí roste nad meze 

povolené pro trvalý provoz a vznikají následující rizika: 

o zkrácení životnosti izolace 

o poškození izolace 

o zvýšení pravděpodobnosti zemního zkratu 

5.2 Vnitřní poruchy 

 

Tyto poruchy transformátorů dělíme na dvě skupiny: 

o Vnitřní poruchy objevující se pozvolna - špatné galvanické styky, špatná izolace 

plechů, vznikající mikrooblouky v nádobě transformátoru, poruchy chlazení. Poruchy 

projevující se pozvolna může v počátečním stavu zachytit pouze plynové relé. V tom 

případě nedojde k masivnímu poškození a je možná oprava transformátoru. 

o Vnitřní poruchy objevující náhle – zkraty. A to zkraty na vinutí, zkraty mezi vinutími, 

zkraty vinutí na nádobu. [13] 

5.3 Příčiny vzniku zkratů 

 

Mezi hlavní příčiny vzniku zkratu patří: 

o nedokonalost izolace – zestárnutím, přetěžováním vodičů apod. 

o vady na elektrickém zařízení – popraskání izolátorů, znečištěním a opálením 

kontaktů, nedbalá montáž, zanedbaná údržba apod. 

o nedostatečné dimenzování – s ohledem na tepelné a mechanické namáhání, apod. 

o přepětí – atmosférická nebo při provozních manipulacích 

o cizí zásahy – při výkopech, stavebních pracích apod. 

Z důvodů stálého kontaktu velkého množství oleje s aktivními vysokonapěťovými prvky se 

považují olejové transformátory za nejrizikovější zařízení v rozvodnách. Přitom transformátory s 

olejovým dielektrikem jsou nejrozšířenějším typem, protože mají na druhé straně celou řadu 

předností. 
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6 OCHRANY TRANSFORMÁTORŮ 
 

Transformátory je nutné chránit jak při vnějších zkratech či přetíženích, tak i při zkratech 

vnitřních. Způsoby chránění pro jednotlivé druhy poruch: [17] 

 

Tabulka 6-1 Způsob chránění jednotlivých druhů poruch 

 Druhy poruch Druhy ochran 

A) Vnější poruchy  

 Přetížení   

Vnější zkrat 

 

Proudová na přetížení (termokopie)  

Nezávislá nadproudová nebo distanční 

1) 

2) 

  

 

Rozdílová ochrana a plynové relé  

Nádobová (kostrová ochrana) 

B) Vnitřní poruchy 

a) Objevující se náhle 

  1. zkraty ve vinutí 

  2. zkraty vinutí na nádobu 

b) Projevují se pozvolna 

Plynové relé 

  

1. špatné galvanické styky, 

špatná izolace plechů, 

vznikají mikrooblouky v 

nádobě - vývin plynů v oleji 

  

2. porucha chlazení - přehřátí 

oleje - vývin plynů 
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6.1 Vybavení transformátorů ochranami 

 

Na základě zkušeností a doporučení ČSN 33 3051 se užívá nejčastěji těchto druhů ochran 

silových transformátorů: 

6.1.1 Transformátory do výkonu 1 MVA 

 

o proti zkratu na primární straně jistíme výkonovými pojistkami vn. Doporučuje se 

použití pojistky s indikací působení 

o plynovým relé, pokud se jím vybaví transformátor jištěný pojistkami, slouží relé pro 

signalizaci.  

Jestliže je transformátor vybaven na primární straně vypínačem, pak se použije pro 

jeho chránění nadproudová ochrana a plynové relé se zapojením na vypínač. 

o transformátory vn/nn se na straně nízkého napětí jistí proti přetížení jističi 

s tepelnými a zkratovými články. 

6.1.2 Transformátory nad 1 MVA do 5 MVA 

 

o plynovým relé 

o rozdílovou ochranou, avšak pouze ve zdůvodněných případech 

o nadproudovou ochranou proti zkratům. Lze ji kombinovat s blokováním na podpětí 

o nadproudovou ochranou proti přetížení se signalizací přetížení 

6.1.3 Transformátory nad 5 MVA 

 

o plynovým relé 

o rozdílovou ochranou, je-li výkon větší než 63 MVA. Pro menší výkony se rozdílová 

ochrana použije ve zdůvodněných případech, např. když se žádá rychlé vypnutí z 

důvodů ohrožení spojovacího vedení mezi transformátorem a rozvodnou. 

o zemní nádobovou ochranou, zejména pro transformátory vvn/vvn 

o termokopií (po dohodě s výrobcem stroje) 

o nadproudovou časově nezávislou ochranou. U transformátorů vvn/vvn se doporučuje 

použít na straně nižšího napětí (obvykle strana 110 kV) distanční ochranu působící v 

obou směrech, přičemž do přípojnic je ochrana bez rychlého stupně. V případě, že 

jsou zdroje na obou stranách, používá se dvou distančních ochran jak na primární 

straně, tak na sekundární straně vinutí. [17] 
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7 ROZDÍLOVÁ OCHRANA TRANSFORMÁTORU 

7.1 Základní požadavky na ochrany  

 

Základními požadavky na ochrany jsou: [5]  

o Spolehlivost funkce ochrany znamená, že ochrana nesmí samovolně působit, 

neobjeví-li se porucha. Naopak při poruše nesmí selhat.  

o Selektivita je schopnost ochrany nereagovat na poruchy soustavy, které jsou mimo 

chráněný objekt, nebo se týkají stavové veličiny objektu, na kterou nemá ochrana 

působit. Smysl selektivity je v tom, že je vypínám co nejmenší úsek energetické 

soustavy, který je postižen poruchou. Přitom co největší část nepoškozené soustavy 

zůstane v provozu. Selektivita zmenšuje nebezpečí ztráty stability a zhroucení 

soustavy 

o Rychlost ochrany je dána dobou působení. Velká rychlost ochran zmenšuje nároky na 

dimenzování chráněného objektu. Teplo akumulované při zkratu uvnitř zařízení je 

úměrné době trvání poruchy. 

o Citlivost ochrany je velikost stavové veličiny, na kterou je ochrana nařízená a podle 

níž určuje poruchu. V provozu je nutná určitá bezpečnost chránění. Proto je funkce 

ochrany nastavena na méně nebezpečnou hodnotu stavové veličiny, než odpovídá 

poruše. 

o Přesnost je daná jako procentuální vyjádření skutečné citlivosti ochrany s ohledem na 

možné nastavení ochrany  

7.2 Princip rozdílové ochrany 

 

Jak je patrno z Obrázek 7.1 chráněný objekt je vymezen přístrojovými transformátory proudu 

jejichž sekundární proudy vyhodnocuje nadproudový měřící člen zapojený v příčné větvi vedení 

spojujících obě strany chráněného zařízení. Rozdílová ochrana tak působí pouze v případě vnitřní 

poruchy (zkratu), kdy je hodnota rozdílového proudu větší než citlivost nadproudového 

článku. [18] 

 

 

Obrázek 7.1 Princip činnosti rozdílové ochrany [18] 
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Podstatná výhoda principu rozdílové ochrany spočívá v tom, že provede bez zpoždění 

vypnutí při všech zkratech v libovolném místě chráněné oblasti. Proudové transformátory na 

protějších stranách oddělují chráněnou oblast od zbývající sítě. Toto přesné vymezení je 

základem ideální selektivity, která je vlastní principu rozdílové ochrany. 

 

7.3 Vypínací charakteristika [19] 

 

Při označení fázorů sekundárních proudů I1 a I2 vstupní a výstupní strany chráněného 

objektu (základní frekvence) je amplituda diferenciálního proudu Id definována jako  

21 IIId            ( 7.1 ) 

V normálním provozním stavu, kdy není v zóně chráněné diferenciální ochranou žádná 

porucha, jsou proudy I1 i I2 stejné a diferenciální proud Id = 0. V praxi není hodnota 

diferenciálního proudu v normálním provozním stavu nulová. Při chránění výkonového 

transformátoru je diferenciální proud způsoben nepřesností měřících transformátorů proudu, 

změnou polohy regulační odbočky, proudem transformátoru naprázdno a zapínacím proudem 

transformátoru. Diferenciální proud způsobený nepřesností měřících transformátorů proudu a 

změnou polohy regulační odbočky se zvětšuje přímo úměrně se zatížením transformátoru. U 

stabilizované diferenciální ochrany je proto diferenciální proud nutný k vypnutí (k aktivaci 

ochrany) tím vyšší, čím vyšší je zatěžovací proud chráněného objektu. Velikost zatěžovacího 

proudu je vyjádřena jako stabilizační proud Ib a je definován vztahem 

2

21 II
Ib


           ( 7.2 ) 

 

Obrázek 7.2 Vypínací charakteristika ochrany 
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Základní nastavení stabilizovaného stupně modulu diferenciální ochrany je určeno podle 

Obrázek 7.2 jako 
n

d

I

I 1 . V této části 1 vypínací charakteristiky je diferenciální proud nutný k 

aktivaci ochrany konstantní. Základní nastavení v zásadě zohledňuje proud výkonového 

transformátoru naprázdno, ale tímto parametrem lze také ovlivnit celkovou úroveň (polohu) 

vypínací charakteristiky. 

Popudový poměr je definován vztahem 
2

2

b

d

I

I
. Vyjadřuje průběh charakteristiky v části 2. 

V této části směrnice (sklon) charakteristiky vyjadřuje poměr mezi změnou zatěžovacího proudu 

a změnou diferenciálního proudu nutného k aktivaci vypnutí. Popudový poměr musí zohlednit 

chyby PTP a změny v poloze regulační odbočky výkonového transformátoru. Příliš vysoký 

popudový poměr není vhodný, protože se snižuje citlivost diferenciální ochrany pro vyhodnocení 

mezizávitových zkratů. 

Bod druhého zlomu charakteristiky. Pro vysoké stabilizační proudy Ib/In. Pro sklon 

charakteristiky 100% je nárůst diferenciálního proudu stejný jako odpovídající nárůst 

stabilizačního proudu. 
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7.4 Blokování rozdílové ochrany při zapínacím rázu 

 

Předpokládáme, že chráněný objekt je transformátor. Jeho provoz znázorňuje magnetizační 

křivku na Obrázek 7.3. V normálních podmínkách je hysterezí smyčka souměrná s magnetizační, 

proud mgi  má normální souměrný průběh. Při zapnutí se připojí k napětí jeho magnetizační 

indukčnost s dlouhou časovou konstantou. Vznikne stejnosměrná složka magnetizačního proudu, 

která vysune pracovní bod. Při vypnutí transformátoru v libovolném okamžiku přejde pracovní 

bod na osu 0mgi   

 

Obrázek 7.3 Průběhy magnetického toku a magnetizačního proudu transformátoru 

a) zapnutí transformátoru bez magnetického nárazu,  b) vznik magnetického nárazu 
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Při zapnutí se pracovní křivka nepohybuje souměrně kolem počátky. Po dobu působení 

stejnosměrné složky toku ss  je provoz nesouměrný a dochází k podstatnému zvětšení 

magnetizačního proudu mgi vlivem nasycení jádra. U moderních transformátorů se značně 

využitým železem jádra je zapínací náraz až desetinásobkem jmenovitého proudu Nmg II 10 . 

 Zapínací náraz působí na rozdílovou ochranu jako vnitřní porucha. Pro zajištění selektivity 

musí být ochrana vybavena blokováním při zapínacím rázu. To se dnes nejčastěji realizuje filtry 

na druhou harmonickou, která tvoří podstatnou složku průběhu .mgzapi  Při výskytu druhé 

harmonické se pomocí filtrů zmenšuje citlivost nebo blokuje ochrana. Typická frekvenční 

charakteristika takového filtru je na Obrázek 7.4. Druhá harmonická a stejnosměrná složka 

obsažená v zapínacím nárazu blokuje ochranu. Třetí harmonická obsažená v magnetizačním 

proudu při přepětí a základní harmonická ochrana spouští. Blokování při zapínacím rázu je 

vhodné u všech strojů s magnetickými obvody, tj. nejen u transformátorů. Např. u generátoru při 

pomalém nabuzování (najíždění) sice k nárazu nedojde, ale vzhledem k přechodným stavům 

(nárazové buzení, nárazy ze sítě) je blokování rozdílové ochrany i zde vhodné. [5] 

 

 

Obrázek 7.4 Frekvenční charakteristika blokování zapínacího rázu 

 

  

f1(50Hz) f2= 2f1 f3= 3f1 
f 0 

iblok 
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působí 
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8 DIFERENCIÁLNÍ OCHRANA V OCHRANNÉM A ŘÍDÍCÍM 

TERMINÁLU REF542PLUS [11] 
 

Pro měření použijeme terminál REF542plus, který integruje v jedné jednotce soubor všech 

sekundárních funkcí, které jsou určeny pro rozvodny nízkého, vysokého a velmi vysokého napětí 

tj. chránění, řízení a ovládání, měření, monitorování a samočinnou diagnostiku a komunikaci. 

Integruje v sobě nepřeberné množství ochranných funkcí především pro rozvodny, motory 

generátory a transformátory jako jsou např.: 

 Proudové ochrany (např. nadproudová ochrana zemní). 

 Napěťové ochrany (např. ochrana proti přepětí, podpětí). 

 Ochrany vedení (např. ochrana distanční). 

 Diferenciální ochrany. 

 Tepelné ochrany. 

 Specifické funkce a ochrany motoru (např. čítač počtů rozběhů motoru). 

 Funkce a ochrany zajištění kvality elektrické energie (regulátor účiníku). 

Terminál dále zahrnuje ovládací a automatizační funkce, kterými lze pomocí programového 

vybavení vytvořit jednoduchou logiku pro blokování např. chybné manipulace nebo blokovací 

podmínky mezi jednotlivými poli rozvodny. Logické operace jsou realizovány pomocí 

nejrůznějších typů logických hradel, časovačů, čítačů a klopných obvodů. 

8.1 Základní popis terminálu 

 

Terminál REF542plus se skládá z dvou hlavních částí viz Obrázek 8.1 Základní jednotka 

(Base Unit) a jednotky pro místní ovládání LD HMI (Local Detached Human Machine Interface). 

Obě jednotky mezi sebou komunikují pomocí sériového rozhraní RS32. 

8.1.1 Základní jednotka 

 

Základní jednotka REF 542plus má architekturu mikroprocesorového zařízení, které pracuje 

v reálném čase. Je složena z následujících vyjímatelných modulů: 

 

 Main module – zpracovává všechny informace, vydává povely a realizuje ochranné 

funkce 

 Suppy module – zajišťuje napájení terminálu 

 Analog input module – zajišťuje příjem logických signálů z vývodového pole a 

ovládání binárních výstupů terminálu. 

 Communication module – zajišťuje všechny komunikační procesy (Základní jednotka 

→ HMI, základní jednotka → PC, základní jednotka → ostatní terminály). 
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8.1.2 HMI jednotka 

 

Jednotka HMI je určena pro místní ovládaní pole rozvodny. Jednotka umožňuje operátorovi 

nastavovat ochranné funkce, ovládat primární prvky (např. vypínač), resetovat výstražná hlášení 

(alarmy), měnit pracovní režim terminálu a zobrazuje měřené hodnoty a změnové stavy.  

Základní HMI jednotku tvoří následují prvky: 

 Displej – zobrazuje jednopólové schéma a Menu terminálu. 

 Tlačítko ovládaní primárních prvků pole rozvodny – např. vypínače. 

 Tlačítko pro navigace v menu. 

 Uživatelsky programovatelné LED diody – slouží pro signalizaci nejrůznějších 

poruch. 

 Provozní signalizační diody – poskytují informaci o provozním stavu terminálu. 

 Sloupcové indikátory – slouží pro orientační zjištění velikosti měřené veličiny 

(proudu) 

 

 

Obr. 2-1.:  Základní a HMI jednotka terminálu REF542plus 

  

Jednopólové schéma 

Provozní LED 

 

Programovatelné 

LED 

Sloupcové  

indikátory 

Ovládání prim. objektů 
Tlačítka navigace 

v menu 

Optické  

rozhraní 

Menu 

První modul BIO, výstupy 

Napájení 

Druhý modul BIO, výstupy 

Druhý modul BIO, vstupy 

První modul BIO, vstupy 

Konektor pro 

připojení CT a VT 

Konektor pro připojení 

HMI jednotky 

Servisní port RS232 pro 

připojení k PC 

Senzorové vstupy 

Obrázek 8.1 Zálkadní a HMI jednotka terminálu REF542plus 



 8 Diferenciální ochrana v ochranném a řídícím terminálu REF542plus [11] 

 

46 

8.1.3 Vypínací charakteristika diferenciální ochrany v REF542plus 

 

Vypínací charakteristika diferenciální ochrany v REF542plus znázorněna na Obrázek 8.2 je 

rozdělena do čtyř oblastí v závislosti na velikosti protékajícího stabilizačního proudu. 

 

 

 

Oblast I: 

Tato oblast je určena pro malá proudová zatížení chráněného objektu. Oblast I. je jednoznačně 

charakterizována body  ,0 0di a  ,0bi 0di . V nastavení ochrany se tyto body definují pomocí 

následujících hraničních proudů: 

0di  
threshold current (prahová hodnota rozdílového proudu charakterizující oblast I.), 

0bi  unbiased region limit (stabilizační proud určující velikost oblasti I.). 

 

Oblast II: 

V této oblasti jsou detekovány rozdílové proudy pro normální až středně těžká zatížení 

chráněného objektu. Oblast II. je určena následujícími body  ,0bi 0di a  ,1bi 1di . Tyto body jsou 

v ochraně definovány proudy: 

1di  slightly biased region threshold (prahová hodnota rozdílového proudu oblast II.), 

1bi  slightly biased region limit (stabilizační proud určující velikost v oblasti II.), 

  

 

 

 

id> 

id1 

id0 

    ib0    ib1 

I. II. III. IV. 

    ib 

id 

Obrázek 8.2 Vypínací charakteristika dif. ochrany REF542plus 
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Oblast III: 

Tato oblast slouží k detekování rozdílových proudů při velmi těžkých zatíženích chráněného 

objektu. Oblast III. Je definována body  ,1bi 1di , strmostí S a proudem di .V nastavení ochrany se 

definují následující parametry: 

S  Heavy biased slope (strmost přímky rozdílového proudu v oblasti III.), 

di  Tri by di  (prahová hodnota rozdílového proudu pro oblast III.), 

 

Oblast IV: 

Tato oblast definuje tvar vypínací charakteristiky diferenciální ochrany pomocí nastaveného 

proudu di  v případě překročení povoleného zatížení proudu bi  protékajícího chráněným 

objektem. 

Všechny výše uvedené hraniční proudy definující vypínací charakteristiku diferenciální 

ochrany se nastavují v poměrných jednotkách a jsou vztaženy k jmenovitému proudu 

transformátoru (primárního NI1  
nebo sekundárného NI2 ). 

 

8.2 Nastavení a zapojení terminálu REF 542plus pro testování 

diferenciálních ochrany s použitím PTP 

 

Pro použití terminálu jako diferenciální ochrany transformátoru s CT je nutno použít 

analogový vstupní kartu s minimálně 6 proudovými vstupy. V tomto případě je použita 

analogová měřící karta 750170/807, která disponuje právě 6 proudovými vstupy. Analogové 

vstupy jsou realizovány pomocí oddělovacích transformátorů se dvěma proudovými rozsahy (5A 

a 1A). V tomto případě jsou využity 1A analogové vstupy, čemuž odpovídá i reálné zapojení 

svorkovnice X80. Na tyto analogové vstupy jsou zapojeny transformátory proudu, v našem 

případě je to po jednom transformátoru KOLMA 06 D1 na primárním a na sekundárním vstupu 

ochrany. Pro tripovací signál z ochrany využijeme jednoho binárního výstupu na svorkovnici 

X21 tj. BO1. Tento logický signál v praxi reprezentuje povel rozepnutí výkonového vypínače.  
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8.2.1 Konfigurace terminálu REF542plus s diferenciální ochranou 

 

 Konfigurace terminálu REF542plus se provádí pomocí programu 

  Configuration Tool V4F.07a. Tento program poskytuje především možnost vytvoření řídící 

funkcí a nastavení ochranných funkcí v jazyce FUPLA. Dále slouží pro podrobné nastavení 

jednotlivých modulů připojených k REF542plus (např. modulu analogových vstupů, 

komunikačního modulu). Uživatelské rozhraní programu Configuration Tool s popisem 

základních funkcí je znázorněno na Obrázek 8.4. 

  

S4 

S4 

S5 

S5 

Obrázek 8.3 Zapojení základní jednotky pro testování diferenciální ochrany 
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8.2.1.1 Konfigurace připojení terminálu k PC 

 

 K propojení terminálu s PC použijeme optický sériový kabel. Spustíme program 

Configuration Tool a provedeme nastavení komunikačních parametrů podle Obrázek 8.5 

dialogové okno s nastavením sériového portu se spustí prostřednictvím Main Menu → Connect 

→ Serial port. Stejně nastavený provedeme i pro komunikační port ve Správce zařízení počítače. 

  

 

  

Příslušný sériový 

port ke kterému 

je terminál 

připojen 

Jednoznačná 

identifikace 

jednotky, pokud 

je na jednotku 

připojeno více 

základních 

jednotek. 

Hlavní nabídka Panely nástrojů 

Základní informace 

o objektu 

Hardware 

Preview 

Print 

Save 

Open 

New 

Generate 

report files 

Single line 

diagram 

Drawing 

LED Bars 

Analog outputs 20mA 

Analog inputs 

Analog inputs 20mA 

Version 

Measurement 

I/O status 

Read Fauld recorder 

Send to REF542plus 

Seriál port 

Load from REF542plus 

Obrázek 8.4 Hlavní konfigurační okno s popisem nástrojové lišty 

Obrázek 8.5 Nastavení komunikačních parametrů sériového portu 
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8.2.1.2 Konfigurace modulů 

 

 Konfigurace modulů, které jsou dostupné ve skříni terminálu, se provádí v sekci Main 

menu → Configurace → Hardware. V tomto dialogovém okně se specifikuje počet I/O karet, 

typ karty analogových vstupů, počet karet analogových vstupů/výstupů s proudovou smyčkou 

20 mA, typ použité provozní sběrnice a verze hardwaru HMI jednotky. Nastavení je pro každý 

typ terminálu individuální a záleží jen na vybavenosti jednotky. Následující nastavení je určeno 

pro terminál REF542plus, kterým je vybavena laboratoř elektrických ochran VUT FEKT. 

 

 
 

 

 

V posledním kroku provedeme nastavení jazyka HMI jednotky v sekci Main → HMI → 

Display Language nastavení jazykové sady na English V4.stc a zatrhneme políčko 

Save as default. 

 

8.2.1.3 Konfigurace karty analogových vstupů 

 Konfigurace analogové karty se provádí v Main Menu → Configure → Terminals → 

Analog inputs. Zobrazí se dialogové okno, ve kterém jsou shrnuté všechny informace o 

nastavení analogové měřící karty. Zde se provede nastavení typu použité měřící analogové karty 

a především převodů jednotlivých proudových transformátorů. Dvojklikem na jednotlivé 

transformátory (CT) nastavíme požadované převody tj. v tomto případě 50/1A.  

Normální typ skříně 

2 I/O – slot,  

široký typ skříně 

4 I/O - slot 
Mechanical relay – princip 

mech. relé (verze 2, verze 3) 

Solid state – princip 

transistorových relé 
Kombinace: 3CT + 3CT 

Obrázek 8.6 Nastavení parametrů připojených modulů 
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8.2.2 Vytvoření funkčního schématu v jazyce FUPLA: 

 

FUFLA je grafický programovací jazyk, kde jsou všechny funkce realizovány pomocí 

funkčních bloků. Výhodou programování v tomto jazyce je především názornost a jednoduchost 

tvorby samotného programu. Každý funkční blok realizovaný Fuplou lze charakterizovat vlastní 

funkcí, libovolným počtem binárních vstupů, výstupů a vnějšími parametry. Jako vnější 

parametry je možné si představit napětí U, proud I, časové zpoždění  apod. To se týká 

především funkčních bloků představující ochranné funkce. Vlastní funkce bloku, na základě 

binárních vstupů a vnějších parametrů, vybavuje binární výstupy, které jsou propojeny s 

ostatními funkčními bloky. Všechny takto pospojované bloky tvoří funkční schéma, na jehož 

základě jsou získávány a vyhodnocovány informace z řídících i měřících prvků a jsou 

vybavovány výkonové prvky. 

Grafický editor pro sestavování funkčního schématu se spouští prostřednictvím hlavní 

nabídky Main menu → Configure → Drawing nebo pomocí tlačítka Drawing na nástrojové 

liště. Zobrazí se prázdné okno grafického editoru. 

  

Nastavení převodu 

Přepínání sítě 

Přepínání fáze 

Obrázek 8.7 Dialogové okno pro nastavení analogových vstupů konkrétní nastavení pro CT1 
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8.2.2.1 Základní práce s funkčními bloky a grafickými prvky FUPLY: 

 

Vložení nového bloku – prostřednictvím hlavního menu Main Menu → Insert. 

Vložení nového spoje – prostřednictvím pravého tlačítka myší, pomocí funkce táhnout z výstupu 

jednoho funkčního bloku do vstupu druhého funkčního bloku. Vhodnější a přehlednější je ovšem 

využití tzv. „virtuálního spoje“ zobrazeného na Obrázek 8.8. Z jednoho i druhého funkčního 

bloku je vyveden jen krátký spoj a vlastní propojení je provedeno virtuálně pomocí čísla spoje 

(Net number) v konfigurační tabulce daného spoje. 

  

 

 

Zobrazení konfigurační tabulky spojů a jednotlivých funkčních bloků – prostřednictvím dvojkliku 

levého tlačítka myši na daný prvek.  

Posun spojů a funkčních bloků – prostřednictvím levého tlačítka myši, pomocí funkce uchopit 

přesunout a pustit. Aby byla manipulace s bloky a spoji umožněna, musí být odškrtnuto 

blokování pohybu bloků v sekce Options → Block Moving of Ojects.  

Vymazání spoje a funkčního bloku – prostřednictvím dvojkliku pravého tlačítka myši na daný 

funkční blok. 

  

Číslo spoje (Net number) 

Virtuální realizace spoje 

Fyzická realizace spoje 

Číslo spoje 

Další nevyužité číslo 

spoje 
Max počet spojů 

Celkový počet použitých spojů 

Komentář 

Obrázek 8.8 Fyzická a virtuální realizace spoje mezi funkčními bloky, konfigurační tabulka. 



 8 Diferenciální ochrana v ochranném a řídícím terminálu REF542plus [11] 

 

53 

8.2.2.2 Postup při sestavování funkčního schématu diferenciální ochrany 

 

 Při vytváření funkčního schématu pro testování diferenciální ochrany postupujeme 

Následovně. Na pracovní plochu vložíme funkční bloky: 

- diferenciální ochrany Insert → Differential → protection → Differential protection. 

- logické jedničky Insert → Digital logic 1 → Constant 1, 

- binárního výstupu Insert → Binary IO → 1-0, 

- invertoru Insert → Digital logic 1 → inverter, 

- signalizační LED Insert → Control Panel → Indication LED, 

- logické funkce OR Insert → Digital logic 1 → 2 Inp-OR, 

- povelu z HMI jednotky Insert → Control Panel → HMI Command. 

- Zapisovač chyb Insert → Fault recorder 

 

Nyní je nutno provést propojení jednotlivých bloků stejně jako je naznačeno na Obrázek 8.9 

pomocí postupu popsaného v kapitole 8.2.2.1. Jednotlivé spoje lze i podle obrázku popsat pro 

lepší přehlednost. 

 

 

 

  

Invertor 

Diff. ochrana 

HMI 

povel 

OR 

LOG1 

Signalizační LED 

Poruchový zapisovač 

Binární výstup 

Obrázek 8.9 Vytvořené funkční schéma pro testování diferenciální ochrany. 
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Po propojení všech prvků provedeme parametrizaci následujících funkčních bloků. V bloku 

Differential protection se v záložce Current provádí nastavení vypínací charakteristika 

diferenciální ochrany, jak je popsáno v kapitole 8.1.3. V záložce Transformer group lze nastavit 

měření jiného hodinového úhlu než 0° s krokem 30°. V dalším bloku 1-0 (binární výstup) je 

nutno specifikovat číslo fyzického binárního výstupu, kterému bude tento blok přiřazen. Jelikož 

blok bude reprezentovat BO1 nastavíme Output No.: 1. Dále provedeme nastavení bloku HMI 

Command. Tento blok zde plní funkci manuální aktivace tripovacího signálu pro otestování 

tripovacího signálu. V parametrizaci se definuje jen název povelu např. Manual Trip, který se 

objeví na HMI jednotce v sekci Commands, přes HMI jednotku se tento signál taktéž aktivuje. 

Dalším blokem, který vyžaduje parametrizaci je blok signalizační LED. Zde se určí číslo LED, 

která se má rozsvítit a zapíše se text, které se zobrazí na HMI jednotce v sekci Alarms v případě 

rozsvícení jednotlivých barev např. green: STATUS, red: TRIP. Dále nastavíme blok Fault 

recorder. Zde provedeme pojmenování jednotlivých analogových vstupů, které jsou definovány 

v záložce Analog inputs, dále nastavíme dobu záznamu. Doba záznamu před poruchou na 200ms 

a dobu záznamu po poruše na 2000ms, celkovou dobu záznamu na vyrovnávací paměti nastavíme 

na 2500ms. 

Celý projekt je potřeba nakonec uložit File → Save a nahrávat do ochrany Connect → Send 

to REF542plus. Je potřeba říci, že při každé změně nastavení ve funkčním schématu je nutno 

nahrát celou konfiguraci do terminálu znovu.  

 

8.2.2.3 Popis funkce vytvořeného funkčního schématu 

 

V normálním provozním stavu je signál D_TRIP roven 0, tudíž i signál pro Binární výstup 

je roven 0 a je rozepnutý. Signál je v invertoru negován a přiveden na vstup green signalizační 

LED. Na HMI jednotce bude v tomto stavu svítit zelená LED s popisem: STATUS. V případě, že 

diferenciální ochrana zaznamená větší proud než je povolený signál D_TRIP se překlopí do 

logické 1. Do logické jedničky se překlopí i signál pro Binární výstup BO1 a sepne. Signalizační 

LED změní barvu na červenou s popisem: TRIP. Aby byl Binární výstup aktivní, musí být na 

jeho vstup IL přivedena LOG1. Pokud provedeme povel přes HMI jednotku, překlopí se do 

logické jedničky signál M_TRIP a binární výstup sepne. Poruchový zapisovač se aktivuje stejným 

signálem jako Binární výstup. 
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8.3 Nastavení a zapojení terminálu REF 542plus pro testování 

diferenciálních ochrany s použitím senzorů RC 

 

Pro použití terminálu jako diferenciální ochrany transformátoru s RC je nutno použít 

analogový vstupní kartu s minimálně 6 senzorovými vstupy. V tomto případě je použita 

analogová měřící karta 750138/803, která disponuje 8 senzorovými vstupy. Na tyto vstupy jsou 

zapojeny proudové senzory, v našem případě je to po jednom transformátoru KECA 80 A1 na 

primárním a na sekundárním vstupu ochrany viz. Obrázek 8.10. Pro tripovací signál z ochrany 

využijeme stejný binárního výstupu BO1 jako u zapojení s PTP. 

 

 

  

  

Obrázek 8.10 Zapojení základní jednotky pro testování diferenciální ochrany s RC 
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8.3.1 Konfigurace karty analogových vstupů se senzory 

 

 Analogové karta 750138/803 je standardně nakonfigurována dle Obrázek 8.11. 

Nejdříve povolíme druhou síť v záložce Network. Dále smažeme vstupy 4-8 v záložce Inputs a 

místo nich nakonfigurujeme vstupy 4-6 jako CR pro druhou síť jak je na Obrázek 8.12 

 

 

 

 

Dvojklikem na jednotlivé senzory (RC) nastavíme požadovaný převod, tj. v tomto případě 

80A/150mV. Pro proudové senzory je v nastavení možno použít korekční faktory pro amplitudu 

a fázi měřeného proudu. Tyto hodnoty jsou štítkové a každý senzor má své vlastní korekční 

faktory měřené při kusové zkoušce.  

  

Obrázek 8.11 Dialogové okno pro nastavení analogových vstupů 
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Korekční faktor amplitudy 

Korekční faktor fáze 

Obrázek 8.12 Dialogové okno pro nastavení převodu a korekčních faktorů konkrétně pro RC1 
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9 MĚŘENÍ S PRIMÁRNÍM TESTREM OMICRON CPC 100 
 

CPC 100 je multifunkční testovací systém, který slouží pro automatizované testování 

výkonových transformátorů, přístrojových transformátorů proudu a napětí a proudových senzorů. 

Měření se provádí vkládáním měřicích karet, ve kterých se nastavují použité vstupy a výstupu. 

Do měřicích karet se postupně navolí požadované hodnoty výstupního proudu a spustí se měření. 

Naměřené hodnoty se ukládají do karet a po skončení měření je lze uložit na externí médium 

pomocí USB rozhraní. Na Obrázek 9.1 je zobrazen čelní panel testovacího systému CPC 100, 

kterým se ovládá měření. [3] 

 

Obrázek 9.1 Čelní panel testovacího systému CPC 100 [20] 

 

Tento systém je vybaven výstupem vysokého napětí o velikosti 2 kV AC, proudovými 

výstupy 400 A DC a 800 A AC. Po připojení externího zesilovače je možné dosáhnout hodnoty 

výstupního proudu až 2000 A AC. 

Proudové výstupy z CPC 100 jsou s měřeným přístrojem propojeny kabely, které jsou na 

jednom konci vybaveny speciálními konektory a na druhém konci kleštěmi. Pro zvýšení rozsahu 

měření použijeme externí zesilovač proudu CP CB2. Ten nám umožní nastavovat proudy až do 

hodnoty 2000 A. Zesilovač proudu se propojí s CPC 100 speciálním kabel s koncovkami, jak je 

zobrazeno na Obrázek 9.2, tím získáme výstupní až 2000 A AC 
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Obrázek 9.2 Zapojení zesilovače na rozsah 2000 A [20] 

9.1 Měření přístrojového transformátoru proudu s primárním 

testrem CPC 100 

 

Jak již bylo zmíněno výše, k měření jsme požili přístrojové transformátory proudu firmy 

ABB a to KOLMA 06 D1 s možností přepínání odboček. Měřící transformátor proudu má tyto 

štítkové hodnoty:  

KOLMA 06D1 

50-150-500-750//5; 20//1A                        50Hz 

S1-S2-S3-S4-S5   cl.10P10 0.5-3-10-15VA 

S1-S2 50/5A cl.10P10 0.5VA 

S2-S3 100/5A cl.10P10 1.5VA 

S3-S4 70/1A cl.10P10 1VA 

S4-S5 50/1A cl.10P10 0.5VA 

S1-S5 150/1A cl.10P10 4VA 

P1x-P2x 20/1A     

ext. 120% Ith: 60xIpn(1s)kA 

0.6/3/-kV Idyn: 2,5xIthkA 

 

Pro měření zvolíme zapojení S4-S5 s převodem 50/1, to má však jmenovitý výkon jen 

0.5VA, pokud chceme proměřit všechny pracovní stavy transformátoru i jeho přesycení, je menší 

jmenovitý výkon lepší. 

Pro nastavení jmenovité zátěže PTP zapojíme obvod podle Obrázek 9.3. Jako zátěž 

sekundárního obvodu je zapojen reostat. Testovací vedení je kabel AXEKCY 150mm2 
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Na primárním testru Omicron CPC 100 si nejdříve nastavíme proudové kleště C-PROBE1 

v záložce Device Setup nastavíme vstup V2 AC a převod 0,1000 V/A. Dále vložíme měřicí kartu 

CT Ratio1 (and Burden) pro měření zátěže. V této záložce nastavíme rozsah na AC 2000 A, 

primární proud 50A, sekundární 1A a spustíme měření nastavením testovacího proudů 50A. 

Změnou polohy jezdce reostatu nastavíme jmenovitou hodnotu zátěže pro jmenovitý proud 50A. 

Po nastavení zátěže přepojíme obvod podle schématu na Obrázek 9.4. Nyní vkládáme měřicí 

karty Sequencer, které nám umožňují vkládat více měřených hodnot do jedné karty. Postupně 

nastavujeme požadované hodnoty primárních proudů od maximální hodnoty 2000 A do 

jmenovitých 50A. Mezi jednotlivé nastavené hodnoty proudu vkládáme časovou prodlevu zhruba 

5s, z důvodu zamezení oteplení jak testovacího vedení, tak i sekundárního vinutí transformátorů 

proudů, které je navinuto vodičem o průměru cca 2mm
2
. Kleštěmi C-PROBE1, připojené na 

napěťový vstup V2, měříme rozdíl sekundárních proudů transformátorů. V kartě Sequencer si 

necháme zaznamenat proud I Out a I Clamp. Všechny naměřené výsledky uložíme a graficky 

zpracujeme. Měření zopakujeme pro různé hodnoty nerovnoměrné zátěže připojené k PTP, tím 

napodobujeme různé délky vodičů od PTP k ochraně a také tím napodobujeme nepřesnost 

způsobenou převodem transformátorů. 

 

 

S4 

S4 S5 

S5 

Obrázek 9.3 Schéma zapojení pro nastavení jmenovité zátěže 
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Na Obrázek 9.5 je zobrazen průběh rozdílového proudu pro tři stavy zatížení PTP a je zde 

zobrazena nejcitlivější vypínací charakteristika rozdílové ochrany REF542plus. Jak je vidět 

v detailu Obrázek 9.6, tato charakteristika je vyhovující jen pro jmenovité zatížení PTP, ve 

zbylých případech by ochran reagovala falešně, proto je třeba citlivost charakteristiky upravit, jak 

je vidět na Obrázek 9.7 

  

S4 

S4 S5 

S5 

Obrázek 9.4 Schéma zapojení pro měření přesnosti 
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Obrázek 9.5 Změřené hodnoty PTP 

 

Obrázek 9.6 Detail změřených hodnot PTP 

 

Obrázek 9.7 Detail upravené charakteristiky 
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K většímu diferenciálnímu proudu dochází kvůli přesycení jednoho z PTP, jak je na Obrázek 

9.8. To je způsobeno připojením větší zátěže k PTP, ten se pak snadněji přesytí. 

 

 

  

CT 0,7VA 

CT 2,3VA 
CT 0,9VA 

Průběhy na PTP 

Obrázek 9.8 Přesycení PTP primárním testrem 
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9.2 Měření proudových senzorů RC s primárním testrem CPC 100 

 

Jak již bylo zmíněno výše, k měření jsme požili senzory RC firmy ABB a to 

KECA 80 A1. Použité proudové senzory RC mají tyto štítkové hodnoty:  

 

Type: KECA 80A1   Type: KECA 80A1  

Ith/Idyn: 31,5(3s)/80kA fr: 50/60Hz Ith/Idyn: 31,5(3s)/80kA fr: 50/60Hz 

Ipr:80A        cl:1(3) Usr: 0,150V, 50Hz Ipr:80A        cl:1(3) Usr: 0,150V, 50Hz 

Cfs: 1,0051  pl:+0,093 Usr: 0,180V, 60Hz Cfs: 1,0043  pl:+0,095 Usr: 0,180V, 60Hz 

 

 

Pro toto měření zapojíme senzory KECA do karty 750138/803 a pomocí napěťových sond, 

napojených dle Obrázek 9.9, budeme měřit rozdílové napětí senzorů, ochranu necháme vypnutou. 

Schéma zapojení obvodu je dle Obrázek 9.10.  

 

Obrázek 9.9 Zapojení napěťové sondy 

 

Na primárním testru Omicron CPC 100 vložíme měřicí karty Sequencer. Postupně 

nastavujeme požadované hodnoty primárních proudů od maximální hodnoty 2000 A do 50A. 

Mezi jednotlivé nastavené hodnoty proudu vkládáme časovou prodlevu zhruba 5s. Pomocí 

napěťových sond zapojených tak, aby se vzájemně odčítali, připojené na napěťový vstup V2, 

měříme rozdílové napětí senzorů RC. V kartě Sequencer si necháme zaznamenat proud I Out a 

V2 AC. Všechny naměřené výsledky uložíme a graficky zpracujeme.  

  



  9 Měření s primárním testrem Omicron CPC 100 

 

65 

 

 

Na Obrázek 9.11 je zobrazen průběh rozdílového proudu RC a je zde zobrazena nejcitlivější 

vypínací charakteristika rozdílové ochrany REF542plus. Tato charakteristika je vyhovující a i ve 

velkých nadproudech, kde je chyba stále velmi malá. V detailu charakteristiky Obrázek 9.12 

vidíme průběh chyby rozdílového proudu pro I a II Oblast, tuto chybu by ochrana změřila ještě 

menší při použití korekčních faktorů. 

  

Obrázek 9.10 Schéma zapojení pro nastavení jmenovité zátěže 
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Obrázek 9.11 Změřené hodnoty RC 

 

 

Obrázek 9.12 Detail změřených hodnoty RC 
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10 MĚŘENÍ SE SEKUNDÁRNÍM TESTREM OMICRON CMC 

256 PLUS 
 

Počítačem řízený testovací systém používá koncept funkčního rozdělení mezi softwarem 

běžícího na počítači a hardwarem CMC 256 připojeným ke zkušebnímu objektu. Zkušební 

software OMICRON Test Universe. 

• Kontroluje zkušební signály 

• Zpracovává naměřená data 

• Vytváří zprávy 

• Generuje údaje 

CMC 256 zkušební souprava 

• Generuje testovací signály (proudy, napětí, binární signály) 

• Měří reakci (analogové a binární) ze zkušebního objektu 

• Dodává stejnosměrný proud pro testování objektů. 

 

 

Obrázek 10.1 Čelní panel testovacího systému CMC 256 plus [21] 
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10.1 Modul Advanced TransPlay 

 

Po spuštění souboru OMICRON start  Page se otevře prostředí OMICRON Test Universe, 

zde si spustíme modul Advanced TransPlay,tímto modulem mohou být data, která byla získána z 

reálných nebo simulovaných poruch, importována, zpracována nebo generována do testovaného 

objektu. Data pocházející z jiných zdrojů (simulační programy) než ze zapisovačů poruch musí 

být v podporovaném formátu. Formáty určené pro import jsou: 

 

- soubory datového formátu Comtrade - *.cfg, *.dat, *.hdr 

- soubory formátu L4 - *.pl4 

- soubory formátu TRF - *.trf 
 

Uživatelské rozhraní programu Advanced TransPlay s popisem základních funkcí je 

znázorněno na Obrázek 10.2. 

 

 

10.2 Nastavení modulu Advanced Transplay 

 

Záznam typu Comtrade importujeme – volíme možnost (bez profilu). Po importování signálu si 

nastavíme Hardwarovou konfiguraci OMICRONU CMC 256plus. V záložce Parametrs → HW 

konfigurace → Všeobecně → Zkušební souprava → Detaily si nastavíme proudové výstupy 

1x37,5A; 420VA @ 22,5A; 20Uef dle tohoto nastavení se provede i zapojení proudových 

výstupů.  

 

Obrázek 10.3 Zapojení proudových výstupů 

Nový 

Otevřít 

Uložit 

Detailní 

zobrazení 

Zobrazení 

časového 

průběhu 

Hardwarová 

konfigurace 

Spuštění 

testu 

Vymazání 

předchozího 

měření 

Obrázek 10.2 Popisem nástrojové lišty Advanced TransPlay 
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V záložce Parametrs → HW konfigurace → Binární / Analogové vstupy se připojí 

binární vstup Bin. In. 10 Obrázek 10.4. Tímto vstupem se následně spustí testovací signál  

 

 

Obrázek 10.4 Binární vstupy 

 

V okně Detailní zobrazení v záložce Analogové výstupy nastavíme požadovaný signál a jeho 

velikost, která je závislá na zvolení proudových výstupů a na samotné proudové smyčce testovacího 

objektu, tak aby nedošlo k přetížení proudových výstupů OMICRONU CMC256plus. Nastavením 

podmínky Startu zkoušky v záložce Všeobecně nastavíme od Bin. vstup 10. 

 

 

 

  

Zvolený průběh 

proudu 

Procentní 

velikost proudu  

Start zkoušky od 

Bin. vstupu 10  

Obrázek 10.5 Detailní zobrazení - Analogové výstupy 
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10.3 Měření přístrojového transformátoru proudu a proudových 

senzorů RC pomocí sekundárního testru CMC 256plus 

 

Pro měření reakce PTP na různé průběhy signálů zapojíme obvod podle Obrázek 10.6. Testovací 

vedení je tvořeno 10 závity kabelem 4x4mm2, kde jsou jednotlivé vodiče zapojeny v sérii, celkově tak 

získáme na PTP 40-ti násobek výstupního signálu z OMICRONU CMC 256plus. Jako zátěž 

sekundárního obvodu je zapojen reostat. Test pustíme tlačítkem , samotný průběh testovacího 

signál se začne generovat po přivedení signálu na Bin. vstupu 10, ten získáme z binárního výstupu 

BO1 ochrany REF542plus, kdy v jednotce HMI v sekci Commands spustíme Manual Trip, tím se 

také aktivuje poruchoví zapisovač ochrany a signál se zaznamená. 

 

 

 

 

Pro měření s proudovými senzory RC obvod zapojíme dle Obrázek 10.7. 

  

S4 S4 S5 S5 

Obrázek 10.6 Schéma zapojení PTP 
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Pro testování máme k dispozici několik signálů poruch, které postupně importujeme do 

programu Advanced TransPlay a provedeme měření. Všechny průběhy zaznamenané ochranou si 

uložíme a následně provedeme porovnání signálů.  

  

Obrázek 10.7 Schéma zapojení RC 
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První testovací signál (Porucha 1) je souměrný zkratový proud. Jak je vidět na Obrázek 10.8 

proudové transformátory čtou tento signál dobře. Diferenciální proud vzniká jen díky různému 

zatížení transformátorů. Stejný signál změřený proudovými senzory RC je na Obrázek 10.9. I zde 

je dobrá odezva na signál, chyba rozdílového proudu je zde velmi malá.  

 

 

  

CT 0,4VA 

CT 1,2VA 

CT 0,6VA 

CT 0,6VA 

Průběhy proudů zaznamenaný různě zatíženými PTP 

CT 0,4VA – CT 0,6VA 

CT 0,6VA – CT 1,2VA 

Průběh rozdílového proudů pro různě zatížené PTP 

Porucha 1 

Obrázek 10.8 Porucha 1, PTP 
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RC1 RC2 

Průběhy proudů zaznamenaný RC 

RC1 - RC2 

Průběh rozdílového proudů pro RC 

Porucha 1 

Obrázek 10.9 Porucha 1, RC 
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Další testovací signál (Porucha 2) je nesouměrný zkratový proud. Jak je vidět na Obrázek 

10.10 proudové transformátory čtou tento signál jen určitou dobu, pak se vlivem přesycení 

stejnosměrné složky transformátory odmlčí a přestanou věrohodně přenášet signál. Vlivem 

různého zatížení transformátorů dojde k přesycení v jiném okamžiku. Diferenciální proud vzniká 

právě tímto přesycením, jak ukazuje Obrázek 10.10. Stejný signál změřený proudovými senzory 

RC je na Obrázek 10.11.  

 

 

CT 0,4VA CT 0,6VA 

CT 1,2VA CT 0,6VA 

CT 0,4VA – CT 0,6VA 

CT 0,6VA – CT 1,2VA 

Průběhy proudů zaznamenaný různě zatíženými PTP 

Průběh rozdílového proudů pro různě zatížené PTP 

Porucha 2 

Obrázek 10.10 Porucha 2, PTP 
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U průběhů poruchy 2 změřené senzory nedochází k přesycení, signál je na obou senzorech 

změřen stejně a diferenciální proud je malý. 

 

 

 

 

RC1 RC2 

RC1 - RC2 

Průběh rozdílového proudů pro RC 

Průběhy proudů zaznamenaný RC 

Porucha 2 

Obrázek 10.11 Porucha 2, RC 
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Porovnáme-li průběhy signálů Obrázek 10.12, vidíme jak PTP a proudové senzory přenášejí 

signál se stejnosměrnou složkou. Transformátory proudu se vlivem stejnosměrné složky přesytí a 

dále už přenáší jen zdeformovaný střídavý signál. Proudové senzory stejnosměrnou složku 

nepřenáší, nedochází u nich k přesycení, střídavá složka je přenesena bez deformace. 

 

 

 

  

 

 

 

 

 

 

 

 

   

 

 

0 

Přesycení CT 

Zdeformovaný signál 

Obrázek 10.12 Porovnání naměřených hodnot poruchy 2 
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Další testovací signál (Porucha 3) je zemní spojení. Jak je vidět na Obrázek 10.13 signál 

zapsaný poruchovým zapisovačem nestíhá zaznamenat vyšší frekvence v tomto signálu. Je to 

zapříčiněno vzorkovací frekvencí zapisovačem, která je 1,2kHz, to znamená 24 vzorků za 20ms. 

Stejný signál změřený proudovými senzory RC je na Obrázek 10.14.  

 

 

 

CT 0,4VA CT 0,6VA 

CT 1,2VA CT 0,6VA 

CT 0,4VA – CT 0,6VA 

CT 0,6VA – CT 1,2VA 

Průběhy proudů zaznamenaný různě zatíženými PTP 

Průběh rozdílového proudů pro různě zatížené PTP 

Porucha 3 

Obrázek 10.13 Porucha 3, PTP 
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RC1 - RC2 

Průběhy proudů zaznamenaný různě zatížený RC 

Průběh rozdílového proudů pro RC 

Porucha 3 

Obrázek 10.14 Porucha 3, RC 
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11 ZÁVĚR 
 

Současně používané principy ochranných funkcí digitálních ochran vycházejí zpravidla z 

vyhodnocení analogových signálů proudů a napětí chráněného objektu. Zdrojem těchto vstupních 

analogových signálů byly od počátku vzniku elektrického chránění zpravidla přístrojové 

transformátory proudu a napětí. S nástupem senzorů, které stále častěji nahrazují především 

klasické přístrojové transformátory proudu, je třeba počítat s kvalitativně i kvantitativně jiným 

typem signálu na vstupu digitální ochrany. Na základě toho může dojít i k přehodnocení řady 

ochranných funkcí, jejichž koncepce byla postavena právě na základě spolupráce s klasickými 

přístrojovými transformátory proudu. 

První bod praktické část, bylo proměření PTP a proudových senzorů pomocí primárního 

testru CPC100. Porovnáme-li Obrázek 9.5 a Obrázek 9.11 vidíme, že při použití PTP je třeba 

dbát na dodržení jmenovitého zatížení, kdy při vyšších proudech, zhruba 20 násobku jmenovitého 

a při různých zátěžích dochází k přesycení PTP a vzniká velký diferenciální proud. Stejně tak by 

se projevila chyba převodů PTP. Vezmeme-li v potaz všechny tyto chyby a chybu přesnosti PTP, 

je třeba upravit vypínací charakteristiku tak, aby ochrana nepůsobila falešně. Při použití senzorů 

RC je diferenciální proud malý v celém rozsahu vypínací charakteristiky ochrany. Z toho pohledu 

je vhodné nastavit vypínací charakteristiku na co nejcitlivější hodnoty. V Oblastech III a IV, 

vypínací charakteristiky ochrany REF542plus, nám softwarové nastavení dovoluje zadat napevno 

dané minimální hodnoty. Pro využití výhod proudových senzorů, by bylo zapotřebí upravit toto 

nastavení, abychom docílili „položení“ vypínací charakteristiky ochrany. 

V další části měření jsem testoval PTP a proudové senzory na různé průběhy poruch pomocí 

sekundárního testru CMC256plus. Zásadní rozdíl v naměřených průbězích, byl při nesouměrném 

zkratu (porucha 2), kdy se PTP vlivem stejnosměrné složky přesytí a vzniká tak diferenciální 

proud jak ukazuje Obrázek 10.10. Oproti tomu proudové senzory, u kterých k přesycení 

nedochází, přenáší signál spolehlivě a diferenciální proud je malý jak lze vidět na Obrázek 10.11. 

I pro tento případ platí, že vypínací charakteristika rozdílové ochrany se musí upravit dle 

vlastností PTP, zatímco na proudové senzory nejsou takové požadavky.  

Proudové senzory se pro své vlastnosti jeví jako ideální způsob měření proudů, přesto se 

jejich plné využití v praxi neuplatňuje.  
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PŘÍLOHA B 
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0,540VA  0,546VA 
 

0,828VA  0,658VA 

Aprim (A) Idif (mA) Id (A)   ib id 
 

Aprim (A) Idif (mA) Id (A)   ib id 

1500 340,7 17,0   30 0,3407 
 

1400 850,0 42,5   28 0,8500 

1400 319,0 16,0   28 0,3190 
 

1387 825,0 41,3   27,74 0,8250 

1300 296,0 14,8   26 0,2960 
 

1300 780,0 39,0   26 0,7800 

1200 270,8 13,5   24 0,2708 
 

1200 713,0 35,7   24 0,7130 

1100 251,1 12,6   22 0,2511 
 

1100 649,0 32,5   22 0,6490 

1000 228,7 11,4   20 0,2287 
 

1000 591,0 29,6   20 0,5910 

900 206,0 10,3   18 0,2060 
 

900 531,0 26,6   18 0,5310 

800 183,4 9,2   16 0,1834 
 

800 471,0 23,6   16 0,4710 

700 160,9 8,0   14 0,1609 
 

700 412,0 20,6   14 0,4120 

600 137,6 6,9   12 0,1376 
 

600 352,7 17,6   12 0,3527 

550 126,0 6,3   11 0,1260 
 

550 322,9 16,1   11 0,3229 

500 114,6 5,7   10 0,1146 
 

500 293,4 14,7   10 0,2934 

450 103,5 5,2   9 0,1035 
 

450 264,0 13,2   9 0,2640 

400 92,1 4,6   8 0,0921 
 

400 234,8 11,7   8 0,2348 

350 76,9 3,8   7 0,0769 
 

350 205,5 10,3   7 0,2055 

300 65,9 3,3   6 0,0659 
 

300 176,3 8,8   6 0,1763 

250 54,7 2,7   5 0,0547 
 

250 146,8 7,3   5 0,1468 

200 44,0 2,2   4 0,0440 
 

200 117,6 5,9   4 0,1176 

150 32,8 1,6   3 0,0328 
 

150 87,8 4,4   3 0,0878 

100 21,9 1,1   2 0,0219 
 

100 58,0 2,9   2 0,0580 

50 10,6 0,5   1 0,0106 
 

50 28,9 1,4   1 0,0289 

0,831VA 1,181VA 
 

RC1  RC2 

Aprim (A) Idif (mA) Id (A)   ib id 
 

Aprim (A) Udif (mV) Id (A)   ib id 

1400 8610,0 430,5   28 8,6100 
 

1500 5,5 2,9   30 0,0583 

1376 8603,0 430,2   27,5 8,6030 
 

1400 4,7 2,5   28 0,0497 

1300 7513,0 375,7   26 7,5130 
 

1300 4,8 2,6   26 0,0512 

1200 5114,0 255,7   24 5,1140 
 

1200 5,4 2,9   24 0,0573 

1100 2465,0 123,3   22 2,4650 
 

1100 5,3 2,8   22 0,0565 

1000 685,0 34,3   20 0,6850 
 

1000 5,0 2,7   20 0,0535 

900 373,5 18,7   18 0,3735 
 

900 4,6 2,4   18 0,0485 

800 321,2 16,1   16 0,3212 
 

800 3,7 2,0   16 0,0390 

700 281,0 14,1   14 0,2810 
 

700 2,7 1,4   14 0,0285 

600 242,4 12,1   12 0,2424 
 

600 1,8 1,0   12 0,0192 

550 222,8 11,1   11 0,2228 
 

550 1,4 0,7   11 0,0149 

500 203,4 10,2   10 0,2034 
 

500 1,2 0,6   10 0,0125 

450 183,4 9,2   9 0,1834 
 

450 1,0 0,5   9 0,0109 

400 163,4 8,2   8 0,1634 
 

400 1,0 0,5   8 0,0109 

350 144,3 7,2   7 0,1443 
 

350 1,0 0,5   7 0,0110 

300 123,6 6,2   6 0,1236 
 

300 1,1 0,6   6 0,0112 

250 102,8 5,1   5 0,1028 
 

250 1,2 0,7   5 0,0130 

200 82,0 4,1   4 0,0820 
 

200 1,2 0,6   4 0,0123 

150 61,7 3,1   3 0,0617 
 

150 1,2 0,7   3 0,0132 

100 41,6 2,1   2 0,0416 
 

100 1,5 0,8   2 0,0156 

50 21,0 1,1   1 0,0210 
 

50 1,7 0,9   1 0,0183 
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PŘÍLOHA C 

 

 


